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This chapter includes: 
• Electrical Safety ................................................................................................................................................................ 12 
• Operational Safety .......................................................................................................................................................... 14 
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• Printer Symbols ................................................................................................................................................................. 17 
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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
 

 1 Safety 
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Electrical Safety 

This section includes: 
• General Guidelines ........................................................................................................................................................... 12 
• Power Cord ......................................................................................................................................................................... 13 
• Emergency Turn Off ........................................................................................................................................................ 13 
• Laser Safety ........................................................................................................................................................................ 13 
 

General Guidelines 
 

 WARNINGS: 

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting 
out a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing optional 
equipment. Except for user-installable options, there are no parts that you can maintain or 
service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
 



Safety 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 13 
 User Guide 
 

Power Cord 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Only use an extension cord or power strip designed to handle the electrical current capacity of the 
printer. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Do not plug or unplug the power cord while the power switch is in the On position. 
• If the power cord becomes frayed or worn, replace it. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

Laser Safety 

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance. 
 

 WARNING: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Operational Guidelines 
• Do not remove any paper trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold its weight. 

To find the weight for your printer configuration, see Physical Specifications on page 256. 
• Do not block or cover the slots or openings on the printer. These openings are provided for 

ventilation and to prevent overheating of the printer. 
• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at the elevations specified in Elevation on page 259. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmenteu&Language=English
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Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox supplies 

recycling programs, go to www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=recyclesupplies&Language=English
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not expose the imaging unit to direct sunlight. 

 

Do not touch the part or area of the printer. 

 

 

Warning: 
Wait for the printer to cool for the specified time before touching the fuser. 

 

This item can be recycled. For details, see Recycling and Disposal on page 277. 

 
 



Safety 

 

18 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmentna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmenteu&Language=English
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 20 
• Rear View ............................................................................................................................................................................ 21 
• Internal Parts ..................................................................................................................................................................... 22 
• Control Panel ..................................................................................................................................................................... 23 
 

Front View 

 
 

1. Tray 1 
2. Bypass Tray 
3. Front Door 
4. Output Tray Paper Stop 
5. Control Panel 

6. Duplex Automatic Document Feeder 
7. Staple Cartridge Door 
8. Output Tray 
9. Front Door Handle 
10. Optional 550-Sheet Feeder 
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Rear View 

 
 

1. USB Type B Port 
2. Ethernet Connector 
3. USB Type A Port 
4. USB Type A Port 
5. Power Connector 
6. Rear Door 

7. Duplex Unit 
8. Transfer Roller 
9. Fuser 
10. USB Memory Port 
11. Fax Line Connector 
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Internal Parts 

 
 

1. Output Tray Paper Stop 
2. Front Door 
3. Toner Cartridges 
4. Duplex Automatic Document Feeder 
5. Document Cover 

6. Document Glass 
7. Staple Cartridge 
8. Waste Cartridge Lock 
9. Imaging Units 
10. Waste Cartridge 

 
 



Features 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 23 
 User Guide 
 

Control Panel 

The control panel consists of a touch screen and buttons you press to control the functions available on 
the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print features. 
• Provides access to reference materials. 
• Provides access to Tools and Setup menus. 
• Provides access to Troubleshooting menus and videos. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
 

 
  

Item Name Description 

1 Touch Screen 
Display The screen displays information and provides access to printer functions. 

2 Services Home 
Button 

This button provides access to printer features such as copy, scan, and fax on the touch 
screen. 

3 Services Button This button returns to the active service from the Job Status or Machine Status screens, 
or to a preset service. 

4 Job Status Button This button displays lists of all active, secure, or completed jobs on the touch screen. 
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Item Name Description 

5 Machine Status 
Button This button displays the status of the printer on the touch screen. 

6 Alphanumeric 
Keypad The keypad enters alphanumeric information. 

7 C (clear) Button This button deletes numeric values or the last digit entered using the alphanumeric keys. 

8 Dial Pause Button This button inserts a pause in a telephone number when it transmits a fax. 

9 Interrupt Button This button pauses the current job to run a more urgent print, copy, or fax job. 

10 Start Button This button starts the selected copy, scan, fax, or Print From job, such as Print from USB. 

11 Stop Button This button stops the current job temporarily. To cancel or resume your job, follow the 
onscreen instructions. 

12 Clear All Button This button clears previous and changed settings for the current selection. Press twice to 
reset all features to their default settings, and clear existing scans. 

13 Power Button This button powers up or powers down the printer. 

14 Language Button This button changes the touch screen language and keyboard settings. 

15 Power Saver button  This button enters and exits the low-power mode. 

16 Help Button This button displays information about the current selection on the touch screen. 

17 Log In/Out Button This button provides access to password-protected features. 
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Information Pages 

Your printer has a printable set of information pages stored on its internal hard drive. Information pages 
include configuration and font information, demonstration pages, and more. 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages, then touch the desired information 

page. 
3. Touch Print. 
 

Note: Information pages can also be printed from Xerox® CentreWare® Internet Services. 
 
 

Printing the Configuration Report 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages > Configuration Report > Print. 
3. Touch Close after the report prints. 
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Administration Features 

This section includes: 
• Accessing the Printer....................................................................................................................................................... 26 
• Xerox® CentreWare® Internet Services ................................................................................................................... 28 
• Automatic Data Collection ........................................................................................................................................... 29 
• Billing and Usage Information ................................................................................................................................... 29 

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs. 
 

Accessing the Printer 

The system administrator can set access rights on the printer to ensure that unauthorized users cannot 
access the printer. If the system administrator configures authentication and authorization, users require 
a login and password to access some or all of the features of the printer. The administrator can also 
configure accounting to require an accounting code to access tracked features. 
 

Authentication 

Authentication is the process of confirming your identity. When the system administrator enables 
authentication, the printer compares the information that you provide to another source of information, 
such as an LDAP directory. The information can be a user name and password, or the information stored 
on a magnetic or proximity ID card. If the information is valid, you are considered an authenticated user. 

The system administrator can set permissions so that authentication is required when accessing features 
at the control panel, in Xerox® CentreWare® Internet Services, or in the print driver. 

If the administrator configures local or network authentication, you identify yourself by typing your user 
name and password at the control panel or in Xerox® CentreWare® Internet Services. If the 
administrator configures card reader authentication, you identify yourself by swiping a magnetic or 
proximity card at the control panel and typing a passcode. 
 

Note: The system administrator can allow you to type your user name and password when Smart 
Card authentication is the primary authentication method. If the administrator configures an 
alternative authentication method, and you misplace your card, you can still access the printer. 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Authorization 

Authorization is the function of specifying the features that you are allowed to access, and the process 
of approving or disapproving your access. The system administrator can configure the printer to allow 
you to access the printer, but restrict your access to certain features, tools, and services. For example, the 
printer can allow you access to copying but restrict your access to color printing. The system 
administrator can also control your access to features at specific times during the day. For example, the 
system administrator can restrict a group of users from printing during peak business hours. If you 
attempt to print using a restricted method or during a restricted time, the job does not print. Instead, the 
printer prints an error page and the job appears with an error message in the Job Status lists. 

Where the system administrator stores the authorization information determines the authorization type. 
• Local authorization stores the login information on the printer in the user Information Database. 
• Network authorization stores the login information in an external database, such as an LDAP 

directory. 

The system administrator sets authorization permissions. To set or edit user permissions for access to 
printer features, you must log in as the administrator. 
 

Accounting 

Accounting monitors the print, copy, scan, and fax impressions produced and who produces them. 

The system administrator must create user accounts and enable the accounting feature. When 
accounting is enabled, you must log in to the printer before accessing services. You must also provide 
your account details in the print driver before printing documents from a computer. The system 
administrator can set limits to restrict the total number of jobs by type that a user can produce. The 
administrator can also generate reports listing usage data for individual users and groups. 

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs. 
 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication. If 
authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the control panel, either press Log In/Out or touch Guest. 
2. If an administrator has configured more than one authentication server, select your domain, realm, 

or tree. 
a. Touch Domain, Realm, or Tree. 
b. From the list, touch your domain, realm, or tree. 
c. Touch Save. 

3. Type your user name, then touch Next. 
4. Type your password, then touch Done. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Logging In to Xerox® CentreWare® Internet Services 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 30. 

 

2. At the top of the page, next to the lock and key icon, click Login. 
3. Type the User ID in the space provided. 
4. Type the password in the space provided. 
5. Click Login. 
 

Administrator Password 

The administrator password is required when accessing locked settings in Xerox® CentreWare® Internet 
Services or at the control panel. Most printer models have a default configuration that restricts access to 
some settings. Access is restricted for settings on the Properties tab in Xerox® CentreWare® Internet 
Services, and settings on the Tools tab on the control panel touch screen. 
 

Logging In as the System Administrator at the Control Panel 
1. At the control panel, press Log In/Out. 
2. Type admin, then touch Next. 
3. Type your password, then touch Done. 

Note: The system administrator user name is admin and the default password is 1111. 
 

Xerox® CentreWare® Internet Services 

Xerox® CentreWare® Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

Xerox® CentreWare® Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in Xerox® CentreWare® Internet Services or the System Administrator Guide. 
 

Accessing Xerox® CentreWare® Internet Services 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 
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Automatic Data Collection 

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a 
designated servicer uses this data to support and service the printer, or for billing, supplies 
replenishment, or product improvement. Automatically transmitted data can include product 
registration, meter read, supply level, printer configuration and settings, software version, and problem 
or fault code data. Xerox cannot read, view, or download the content of your documents residing on or 
passing through your printer or any of your information management systems. 

To turn off automatic data collection: 

On the Welcome page in Xerox® CentreWare® Internet Services, click the link in the note regarding 
automated services. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. The impression counts 
shown are used for billing. 
 

For details, see Billing and Usage Information on page 205. 
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Finding the IP Address of the Printer 

You can view the IP address of your printer on the control panel or on the Configuration Report. On the 
Configuration Report, IP address information is located in the Connectivity Protocols section. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Machine Information tab. 

− If the system administrator has set the Display Network Settings to show the IP address, it 
appears in the center panel. 

− If the IP address is not displayed, print the Configuration Report or contact your system 
administrator. 

To print a Configuration Report: 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages > Configuration Report > Print. 
3. Touch Close after the report prints. 
 



Features 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 31 
 User Guide 
 

Xerox ConnectKey Apps 

There are several Xerox® ConnectKey® Apps available for use with your ConnectKey device. ConnectKey® 
Apps extend the capabilities of your ConnectKey devices. 
• Xerox QR Code: You can use this App to link your mobile applications with ConnectKey devices. You 

can also use the QR Code App to access information about related Xerox® Mobile Apps. 
• Xerox @PrintByXerox: You can use this App to print documents to ConnectKey-enabled devices 

using email submission from any location. 
• Xerox App Gallery 1.0: You can use this App to access, login, browse, and download ConnectKey 

Apps from the Xerox App Gallery. 

For more information about Xerox® ConnectKey Apps, go to www.xerox.com/XeroxAppGallery. 

Notes: 

• The ConnectKey Apps available depend on your device model and software version. 
• To use ConnectKey Apps, ensure that your device is connected to the Internet. 
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More Information 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer • www.xerox.com/office/WC6655docs 
• www.xerox.com/office/WC6655i_docs 

Recommended Media List United States: www.xerox.com/rmlna 
European Union: www.xerox.com/rmleu 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

• www.xerox.com/office/WC6655support 
• www.xerox.com/office/WC6655i_support 

Information about menus or error messages Press the control panel Help (?) button. 

Information pages To print from the control panel, press Machine Status > 
Machine Information > Information Pages. 
To print from Xerox® CentreWare® Internet Services, click 
Status > Information Pages. 

Xerox® CentreWare® Internet Services 
documentation 

In Xerox® CentreWare® Internet Services, click Help. 

Order supplies for your printer • www.xerox.com/office/WC6655supplies 
• www.xerox.com/office/WC6655i_supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful 
tips, and customized features to meet your 
individual needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 

Third party and open source software To locate third party and open source software disclosure 
notices and terms and conditions, go to the product page at: 
• www.xerox.com/office/WC6655support 
• www.xerox.com/office/WC6655i_support 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Welcome Center 

If you need assistance during or after printer installation, visit the Xerox® website for online solutions 
and support at www.xerox.com/office/worldcontacts. 

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada 
at 1-800-835-6100. 

If a local Xerox representative telephone number was provided during printer installation, record the 
telephone number in the following space. 

#_________________________________ 

If you need additional help using your printer: 
1. Refer to this user guide. 
2. Contact the system administrator. 
3. Visit the Xerox® website at www.xerox.com/office/WC6655support. 

To assist you, the Welcome Center needs the following information: 
• The nature of the problem. 
• The serial number of the printer. 
• The fault code. 
• The name and location of your company. 
 

Locating the Serial Number 

To contact Xerox for assistance, you need the printer serial number. The serial number is located at the 
rear of the printer. 

To view the serial number at the printer control panel, press the Machine Status button, then touch the 
Machine Information tab. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................ 36 
• Selecting a Location for the Printer........................................................................................................................... 37 
• Power Cord Safety Information ................................................................................................................................. 38 
• Connecting the Printer ................................................................................................................................................... 39 
• Configuring Network Settings ..................................................................................................................................... 43 
• Modifying General Settings ......................................................................................................................................... 44 
• Installing the Software .................................................................................................................................................. 47 
 

See also: 
Installation Guide packaged with your printer. 
System Administrator Guide at www.xerox.com/office/WC6655docs. 
 
 

 3 Installation and Setup 
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to Xerox® 
CentreWare® Internet Services. 
 

Note: If the Software and Documentation disc is not available, you can download the latest drivers 
from www.xerox.com/office/WC6655drivers. 

  

See also: 
Selecting a Location for the Printer on page 37 
Choosing a Connection Method on page 39 
Connecting the Printer on page 39 
Configuring Network Settings on page 43 
Installing the Software on page 47 
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Selecting a Location for the Printer 

1. Select a dust-free area with temperatures from 5–32°C (41–90°F), and relative humidity 15–85%. 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 256. Select a location with 
adequate clearance to access supplies and to provide proper ventilation. To find the clearance 
requirements for your printer, see Clearance Requirements on page 257. 

3. After positioning the printer, you are ready to connect it to the power source and computer or 
network. 
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Power Cord Safety Information 

Carefully read the following instructions before operating your printer. For details, contact your Xerox 
representative. 
 

 WARNINGS: 

• The electrical supply for the device must meet the requirements stated on the data plate on the 
rear of the device. If you are not sure that your electrical supply meets the requirements, consult 
your local electricity provider or a licensed electrician. 

• Do not use an extension cord. 
• Do not remove or modify the power cord. 

 

Refer to these instructions to ensure the continued safe operation of your printer. 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Replace the power cord if it becomes frayed or worn. 
• Do not unplug or plug the power cord while the printer is turned on. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 
• The electrical outlet must be near the printer and must be easily accessible. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
For details, see Turning the Printer On and Off on page 41. 
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Connecting the Printer 

This section includes: 
• Selecting a Connection Method ................................................................................................................................. 39 
• Physically Connecting the Printer to the Network ............................................................................................... 40 
• Connecting to a Computer Using USB ..................................................................................................................... 40 
• Connecting to a Telephone Line ................................................................................................................................ 40 
• Turning the Printer On and Off ................................................................................................................................... 41 
 

Selecting a Connection Method 

The printer can be connected to your computer using a USB cable or an Ethernet cable. The method you 
select depends on how your computer is connected to the network. A USB connection is a direct 
connection and is the easiest to set up. An Ethernet connection is used for networking. If you are using a 
network connection, it is important to understand how your computer is connected to the network. For 
details, see About TCP/IP and IP Addresses on page 43. 

Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet cables, and USB cables are not included 
with your printer and must be purchased separately. 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
It must be connected through a router or hub. An Ethernet network can be used for one or more 
computers and supports many printers and systems simultaneously. Ethernet connection is typically 
faster than USB and allows you direct access to the settings of the printer using Xerox® 
CentreWare® Internet Services. 

• Wireless Network: If your computer includes a wireless router or wireless access point, you can 
connect the printer to the network with a wireless connection. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to the setting of the printer using 
Xerox® CentreWare® Internet Services. 

• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In 
addition, a USB connection does not provide access to Xerox® CentreWare® Internet Services. 

• Telephone: To send and receive faxes, the multifunction printer must be connected to a dedicated 
telephone line. 
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Physically Connecting the Printer to the Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using Xerox® CentreWare® Internet Services. 

To connect the printer: 
1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 

Connect the other end of the Ethernet cable to a correctly configured network port on a hub or 
router. 

3. Turn on the printer. 
 

Note: For details on configuring wireless network settings, see the System Administrator Guide at 
www.xerox.com/office/WC6655docs. 

 
 

Connecting to a Computer Using USB 

To use USB, you must have Windows 7, Windows Server 2003, and later, or Macintosh OS X version 10.7 
and later. 

To connect the printer to the computer using a USB cable: 
1. Ensure that the printer is turned off. 
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer. 
3. Attach the power cord and then plug in the printer and turn it on. 
4. Connect the A end of the USB cable to the USB Port on the computer. 
5. When the Windows Found New Hardware Wizard appears, cancel it. 

You are ready to install the print drivers. For details, see Installing the Software on page 47. 
 

Connecting to a Telephone Line 
1. Ensure that the printer is turned off. 
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on 

the back of the printer. 
3. Connect the other end of the RJ11 cable to an operating telephone line. 
4. Enable and configure the Fax functions. 

Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• The fax function works best with an analog phone line. Voice-Over Internet Protocols (VOIPs) 
such as FIOS and DSL are not supported. 

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Turning the Printer On and Off 

This printer has both a power switch and a power button. The power switch on the side of the printer 
controls the main power to the printer. The control panel power button controls power to the printer 
electronic components. The preferred software-controlled printer shutdown method is to press the power 
button. 

To turn on the printer: 
• Turn on the power switch. 

 
• If the power switch is on, but the printer is powered off, the printer was turned off using the power 

button. To turn on the printer, on the control panel, press Power. 

To turn off the printer: 
 

 CAUTIONS: 

• To prevent a printer malfunction or damage to the internal hard drive, perform the 
power button shutdown first. After the touch screen goes dark, wait 10 seconds, then 
turn off the power switch. 

• Do not plug or unplug the power cord while the printer is powered on. 
• Ensure that there are no jobs in the queue. 
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1. On the control panel, press Power. 
2. Touch Power Down. 

After 10 seconds, the touch screen goes dark and the Power Saver button flashes until the printer 
has completed powering down. 

 
Note: When all of the control panel lights are off, the printer power off sequence is complete. 
Turning the power switch off is optional. 
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Configuring Network Settings 

About TCP/IP and IP Addresses 

Computers and printers primarily use TCP/IP protocols to communicate over an Ethernet network. 
Generally, Macintosh computers use either TCP/IP or the Bonjour protocol to communicate with a 
network printer. For Macintosh OS X systems, TCP/IP is preferred. Unlike TCP/IP, however, Bonjour does 
not require printers or computers to have IP addresses. 

With TCP/IP protocols, each printer and computer must have a unique IP address. Many networks and 
cable and DSL routers have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server 
automatically assigns an IP address to every computer and printer on the network that is configured to 
use DHCP. 

If you use a Cable or DSL router, see the documentation for your router for information on IP addressing. 
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Modifying General Settings 

You can modify printer settings such as the language, date and time, units of measurement, display 
brightness, and startup page from the control panel. 

Note: If these settings do not appear, contact the system administrator or log in as a system 
administrator. For details see Logging In as the System Administrator at the Control Panel on page 
28. 

1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings > General, then touch the setting you want to change: 

− Energy Saver: This option specifies when the printer goes into energy-saving mode. 
− Date and Time: This option allows you to set the time zone, date, time, and display format. 
− Language/Keyboard Selection: This option allows you to set the language and keyboard 

layout. 
− Custom Keyboard Button: This option allows you to assign text to the custom key on the 

virtual keyboard. 
3. Touch OK. 
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Setting Energy Saver Mode 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower 
power level. 

To configure Energy Saver settings: 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings > General > Energy Saver. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 28. 

3. On the Energy Saver screen, select an option: 
− Intelligent Ready: The printer wakes and sleeps based on previous usage. 
− Job Activated: The printer wakes when it detects activity. To change the default Low-Power 

and Sleep timeout periods, touch Energy Saver Timers. 
• To set the delay before the printer enters Low-Power mode, touch the Minutes field, then 

to set the number, touch the arrows. 
• To set the delay before the printer enters Sleep mode, touch the Minutes field, then to set 

a number, touch the arrows. 
• Touch OK. 

− Scheduled: The printer wakes and sleeps according to a schedule that you specify. To specify 
the schedule, touch Scheduled Settings. 
• Touch a day of the week in the list. 
• To allow the printer to wake when it senses activity on that day, touch Activity. 
• To wake the printer at a specific time, touch Time. To set the time that the printer wakes 

up on the specified day, touch Warm Up Time, then to select the time, touch the arrows. 
Touch OK. To specify the time that the printer sleeps on the specified day, touch Energy 
Saver Time, then to select the time, touch the arrows. Touch OK. 

• Touch OK. 
4. Touch OK. 
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Setting the Date and Time at the Control Panel 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings > General > Date and Time. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 28. 

3. To set the time zone, touch Time Zone, touch the Geographic Region drop-down list, then touch 
your region. Use the Up or Down arrows to navigate and select your Time Zone. 

Note: The date and time are set automatically through Network Time Protocol (NTP). To modify 
these settings, go to the Properties tab in Xerox® CentreWare® Internet Services and change the 
Date and Time Setup to Manual (NTP Disabled). 

4. To set the date: 
a. Touch Date. 
b. Touch Year field, then to set a number, use the arrows. 
c. Touch Month field, then to set a number, use the arrows. 
d. Touch Day field, then to set a number, use the arrows. 
e. Touch Format, touch the date format that you wish to use. 

5. To set the time: 
a. Touch Time. 
b. To specify the 12-hour or 24-hour format, touch Display 24 hour Clock. 
c. Touch the Hours field, then to set a number, use the arrows. 
d. Touch the Minutes field, then to set a number, use the arrows. 
e. If your printer is set to display the 12-hour clock, touch AM or PM. 

6. Touch OK. 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 47 
• Installing Drivers and Utilities for Windows .......................................................................................................... 48 
• Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and Later .................................. 49 
• Installing Scan Drivers for Macintosh ...................................................................................................................... 50 
• Installing Print Drivers and Utilities for UNIX and Linux Printing ................................................................. 50 
• Other Drivers ...................................................................................................................................................................... 52 

Before you install driver software, verify that the printer is plugged in, turned on, connected correctly, 
and has a valid IP address. If you cannot find the IP address, see Finding the IP Address of Your Printer 
on page 30. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC6655drivers. 
 

Operating System Requirements 
• Windows XP SP3, Windows Vista, Windows 7, Windows 8, Windows Server 2003, Windows 

Server 2008, Windows Server 2008 R2, and Windows Server 2012. 
• Macintosh OS X version 10.7 and later. 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. For details, see www.xerox.com/office/WC6655drivers. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=driver&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=driver&Language=English
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Installing Drivers and Utilities for Windows 

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver. 

To install the print and scan driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. The 

installer starts automatically. 
If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. To change the language, click Language. 
3. Select your language, then click OK. 
4. Click Install Drivers > Install Print and Scan Drivers. 
5. To accept the license agreement, click I Agree. 
6. From the list of discovered printers, select your printer, then click Next. 
7. If your printer does not appear in the list of discovered printers, click Extended Search. 
8. If your printer still does not appear in the list of discovered printers, and you know the IP address: 

a. Click the Network Printer icon at the top of the window. 
b. Enter the IP address or the DNS name of the printer. 
c. Click Search. 
d. From the list of discovered printers, select your printer, then click Next. 

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP 
address: 
a. Click Advanced Search. 
b. If you know the gateway address and subnet mask, click the top button and enter the 

addresses into the Gateway and Subnet Mask fields. 
c. If you know the address of another printer on the same subnet, click the middle button and 

enter the address in the IP Address field. 
d. Click Search. 
e. From the list of discovered printers, select your printer, then click Next. 

 

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record 
the IP address for future use. 

 

10. Select the desired driver. 
11. Click Install. 

If the installer prompts you for the IP address, enter the IP address of the printer. 
If the installer prompts you to restart your computer, click Restart to complete the installation of 
the drivers. 

12. To complete the installation, click Finish. 
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Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and 
Later 

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver. 

To install the print and scan driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click I Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. Enter your password, then click OK. 
8. From the list of discovered printers, select your printer, then click Next. 

If your printer does not appear in the list of discovered printers: 
a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

9. To accept the print queue message, click OK. 
10. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
11. Click Continue, then click Close. 

Note: The printer is added automatically to the printer queue in Macintosh OS X versions 10.7 and 
later. 

To verify the installation of printer options with the print driver: 
1. From the Apple menu, click Printer Preferences > Print & Scan. 
2. Select the printer in the list, then click Options and Supplies. 
3. Click Driver, then confirm that your printer is selected. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click OK, close the window, then exit System Preferences. 
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Installing Scan Drivers for Macintosh 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. To view the .dmg file for your printer, double-click the disc icon on your desktop. 
3. Open the Scan Installer.dmg file, then navigate to the appropriate installer file for your operating 

system. 
4. Open the Scan Installer package file. 
5. To acknowledge the warning and introductory messages, click Continue. 
6. To accept the license agreement, click Continue, then click Agree. 
7. Click Continue again. 
8. Enter your password, then click OK. 
9. If prompted to close other installations, click Continue Installing. 
10. To restart, click Log Out. 
 

Installing Print Drivers and Utilities for UNIX and Linux Printing 

For details about UNIX and Linux drivers, see the System Administrator Guide at 
www.xerox.com/office/WC6655docs. 
 

Xerox® Print Driver Package 

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux 
environments. 
 

Xerox® Print Drivers 

You can use a Xerox® print driver to select printer features. All operating systems include the Office 
Standard print driver, which can print to a wide range of Xerox devices that share common features. You 
can use a Linux-based print driver to print to a specific model. 
 

Xerox® Printer Manager 

Xerox® Printer Manager allows you to: 
• Configure local and network-connected printers. 
• Set up a printer on your network as well as monitor the operation of the printer once installed. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Installing Xerox® Print Driver Package 

Before you begin: 

Ensure that you have root or superuser privileges to install Xerox® Printer Manager. 

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the 
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your 
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see 
Finding the IP Address of Your Printer on page 30. 

1. Download the appropriate package for your operating system. 
The available files are: 
− XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family. 
− XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations. 
− XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems. 
− XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems. 
− Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments. 
− Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments. 
− Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments. 
− Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments. 

2. To install the Xerox® Print Driver package, open the package with your OS package manager or use 
the appropriate command-line utility for your OS. 
− AIX: rpm -U XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm 
− HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz \* 
− Solaris (x86 based): pkgadd -d XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg 
− Solaris (SPARC based): pkgadd -d XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg 
− Linux (RPM based 32-bit): rpm -U Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm 
− Linux (Debian based 32-bit): dpkg -i Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb 
− Linux (RPM based 64-bit): rpm -U Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm 
− Linux (Debian based 64-bit): dpkg -i Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb 
The package installs files into /opt/Xerox/prtsys. 

 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 
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Other Drivers 

The following drivers are available for download at www.xerox.com/office/WC6655drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers 

made by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=driver&Language=English
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This chapter includes: 
• Supported Paper ............................................................................................................................................................... 54 
• Loading Paper ................................................................................................................................................................... 58 
• Printing on Special Paper .............................................................................................................................................. 66 
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Supported Paper 

This section includes: 
• Recommended Media .................................................................................................................................................... 54 
• Ordering Paper .................................................................................................................................................................. 54 
• General Paper Loading Guidelines ............................................................................................................................ 54 
• Paper That Can Damage Your Printer ...................................................................................................................... 55 
• Paper Storage Guidelines .............................................................................................................................................. 55 
• Supported Paper Types and Weights ....................................................................................................................... 56 
• Supported Standard Paper Sizes ................................................................................................................................ 56 
• Supported Paper Types and Weights for Automatic 2-Sided Printing ........................................................ 57 
• Supported Custom Paper Sizes ................................................................................................................................... 57 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/rmlna Recommended Media List (United States) 
• www.xerox.com/rmleu Recommended Media List (Europe) 
 

Ordering Paper 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6655supplies. 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
 

http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=order&Language=English
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 

 



Paper and Media 

 

56 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Supported Paper Types and Weights 
 

Tray Paper Types Weights 

All Trays Recycled 
Custom 

60–105 g/m² 

Plain 
Hole Punched 
Pre-Printed 
Bond 
Letterhead 

75–105 g/m² 

Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–163 g/m² 

Cardstock 
Glossy Cardstock 

164–220 g/m² 

Bypass Tray Labels 
Envelope 

 

 
 

Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

All Trays A4 (210 x 297 mm, 8.3 x 11.7 in.) 
B5 (176 x 250 mm, 6.9 x 9.8 in.) 
A5 (148 x 210 mm, 5.8 x 8.3 in.) 
JIS B5 (182 x 257 mm, 7.2 x 10.1 in.) 
215 x 315 mm, 8.5 x 12.4 in. 

Legal (216 x 356 mm, 8.5 x 14 in.) 
Folio (216 x 330 mm, 8.5 x 13 in.) 
Letter (216 x 279 mm, 8.5 x 11 in.) 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
203 x 254 mm, 8 x 10 in. 

Bypass Tray A6 (105 x 148 mm, 4.1 x 5.8 in.) 
B6 (125 x 176 mm, 4.9 x 6.9 in.) 
C5 envelope (162 x 229 mm, 6.4 x 9 in.) 
C6 envelope (114 x 162 mm, 4.5 x 6.38 in.) 
DL envelope (110 x 220 mm, 4.33 x 8.66 in.) 
JIS B6 (128 x 182 mm, 5.0 x 7.2 in.) 
127 x 178 mm, 5 x 7 in. 
Postcard (100 x 148 mm, 3.9 x 5.8 in.) 
Postcard (148 x 200 mm, 5.8 x 7.9 in.) 

Statement (140 x 216 mm, 5.5 x 8.5 in.) 
Monarch envelope (98 x 190 mm, 3.9 x 7.5 in.) 
No. 9 envelope (99 x 226 mm, 3.9 x 8.9 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 
Envelope 6 x 9 (152 x 228 mm, 6 x 9 in.) 
76 x 127 mm, 3 x 5 in. 
Postcard (89 x 140 mm, 3.5 x 5.5 in.) 
Postcard (102 x 152 mm, 4 x 6 in.) 
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Supported Paper Types and Weights for Automatic 2-Sided Printing 
 

Paper Types Weights 

Recycled 
Custom 

60–105 g/m² 

Plain 
Hole Punched 
Pre-Printed 
Letterhead 
Bond 

75–105 g/m² 

Lightweight Cardstock 
Lightweight Glossy Cardstock 

106–163 g/m² 

 
 

Supported Custom Paper Sizes 

Trays 1 and 2 
• Width: 148.0–215.9 mm (5.8–8.5 in.) 
• Length: 210–355.6 mm (8.3–14 in.) 

Bypass Tray 
• Width: 76.2–215.9 mm (3–8.5 in.) 
• Length: 127–355.6 mm (5–14 in.) 

Automatic 2-sided Printing 
• Width: 148.0–215.9 mm (5.8–8.5 in.) 
• Length: 210–355.6 mm (8.3–14 in.) 

Duplex Automatic Document Feeder 
• Width: 148.0–215.9 mm (5.8–8.5 in.) 
• Length: 210–355.6 mm (8.3–14 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in the Bypass Tray ............................................................................................................................. 58 
• Configuring Trays 1 or 2 for the Paper Length ..................................................................................................... 60 
• Loading Paper in Trays 1–2 .......................................................................................................................................... 62 
• Changing Paper Size, Type, and Color ..................................................................................................................... 64 
• Changing Paper Size, Type, and Color ..................................................................................................................... 65 
 

Loading Paper in the Bypass Tray 
1. Open the bypass tray. 

 
2. If the bypass tray is loaded with paper already, remove any paper that is a different size or type. 
3. Move the width guides to the edges of the tray. 
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4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

5. Load the paper in the tray. 
6. Load hole punched paper with the holes to the right. 

 
7. For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face down 

with the top edge going into the printer. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 
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8. Adjust the width guides until they touch the edges of the paper. 

 
9. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
 

Configuring Trays 1 or 2 for the Paper Length 

You can adjust the lengths of trays 1 and 2 to accommodate A4/Letter and Legal paper sizes. In the 
Legal length settings, the trays protrude from the front of the printer. 

To change the 550-sheet feeders in trays 1 and 2 to match the paper length: 
1. Remove all paper from the tray. 
2. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 
3. To extend the tray, with one hand, hold the back of the tray. With the other hand, at the front of 

the tray, press the release latch and pull the ends outward until they latch. 
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4. To compress the tray for shorter paper, with one hand, hold the back of the tray. With the other 
hand, at the front of the tray, press the release latch, then push the ends inward until they latch. 

5. Load paper into the tray, then insert it back into the printer. For details, see Loading Paper in Trays 
1–2. 
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Loading Paper in Trays 1–2 
1. To remove the tray from the printer, pull out the tray until it stops, lift the front of the tray slightly, 

then pull it out. 

 
2. At the back of the paper tray, press the paper lift tray down until it locks. 
3. Adjust the paper length and width guides as illustrated. 

 
4. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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5. Load paper into the tray. 
− Load hole punched paper with the holes to the right. 
− For 1-sided and 2-sided printing, to load letterhead or pre-printed paper, place letterhead face 

down with the top edge going into the printer. 

Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

 
6. Adjust the length and width guides to fit the paper. 

 
7. Slide the tray back into the printer. 
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8. Push in the tray all the way. 

Notes: 

• If the tray does not go in all the way, ensure that the paper lift plate at the back of the tray is 
locked down. 

• If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 
printer. 

9. Do one of the following: 
− To confirm the paper size, type, and color when a tray is set to Fully Adjustable, touch Confirm. 
− To select a new paper size, touch Size. To select a new paper type, touch Type. To select a new 

paper color, touch Color. When finished, touch Confirm. 
− To change the paper size, type, or color when the tray is set to Dedicated mode, press the 

Machine Status button. Then touch Tools > Device Settings > Paper Management > Tray 
Settings. Configure the desired tray settings, for details see Configuring Tray Settings on page 
65. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 28. 

 

Changing Paper Size, Type, and Color 

When trays are set to Adjustable mode, you can change paper settings each time that you load the tray. 
When you close the tray, the control panel prompts you to set the paper size, type, and color of paper 
loaded. 

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, 
type and color. If you move the guides to load a different paper size, the control panel displays an error 
message. 

To configure the tray settings for Fully Adjustable or Dedicated trays see Configuring Tray Settings on 
page 65. 

To set the paper size, type, or color for an adjustable tray: 
1. Open the paper tray, then load the desired paper. 
2. Close the tray. A message appears on the control panel. 
3. Do one of the following: 

− To confirm the paper size, type, and color when a tray is set to Fully Adjustable, touch Confirm. 
− To select a new paper size, touch Size. To select a new paper type, touch Type. To select a new 

paper color, touch Color. When finished, touch Confirm. 
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Changing Paper Size, Type, and Color 

You can set paper trays to Adjustable or Dedicated mode. When trays are set to Adjustable mode, you 
can change paper settings each time that you load the tray. When a paper tray is set to Dedicated 
mode, the control panel prompts you to load a specific paper size, type, and color. You can use the Tray 
Settings option to configure or change the paper tray settings. 

To configure the tray settings: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Tools tab, then touch Device Settings > Paper Management. 
3. Touch Tray Settings, then select a tray. 

− To set the Mode, touch Fully Adjustable or Dedicated. If you select Dedicated, to specify the 
paper settings for a dedicated tray, touch Edit, then set the paper Size, Type, and Color. Touch 
OK. 

− To configure the printer to select the tray automatically, for Auto Selection, touch Enabled. 
− To set the priority for each tray, touch the number field. To enter a number, use the 

alphanumeric keypad, or touch Plus (+) or Minus (-). The printer uses paper from the Priority 1 
tray first. If that tray is empty, the printer uses paper from the Priority 2 tray. 

4. Touch OK. 

Note: To access the Paper Management menu, you can be required to log in as the system 
administrator. For details, see the System Administrator Guide at 
www.xerox.com/office/WC6655docs. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Printing on Special Paper 

This section includes: 
• Envelopes ............................................................................................................................................................................ 66 
• Labels .................................................................................................................................................................................... 69 
• Glossy Cardstock .............................................................................................................................................................. 70 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/WC6655supplies. 
 

See also: 
www.xerox.com/rmlna Recommended Media List (United States) 
www.xerox.com/rmleu Recommended Media List (Europe) 
 
 

Envelopes 

You can print envelopes from the bypass tray only. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=order&Language=English
http://www.xerox.com/printer-supplies/recommended-paper/enus.html
http://www.xerox.com/rmleu
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Loading Envelopes in the Bypass Tray 
1. Open the bypass tray. 

 
2. Move the width guides to the edges of the tray. 

 
Note: If you do not load envelopes in the bypass tray right after they have been removed from the 
packaging, they can bulge. Flatten them to avoid jams. 
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3. To load envelopes, select an option: 
− To load envelopes with long edge flaps, place the envelopes with the short edge going into the 

printer, flaps down and to the right. 

 
− To load envelopes with non-adhesive short edge flaps, place print side up, flaps open and 

down, with the bottom edge entering the printer. 
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• For envelopes with adhesive short edge flaps, load the envelopes with the print side up, 
flaps closed and down, and flaps going into the printer. 

 
Note: To have envelopes print correctly, when you load envelopes with the flaps open, in the print 
driver, select Portrait, Landscape, or Rotated Landscape, as needed. To flip the image, in the print 
driver, use Rotate Image 180 Degrees, as needed. 

4. If the control panel prompts you, verify the paper size, type, and color in the Paper Settings screen. 
 

Labels 

You can print labels from the bypass tray only. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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Loading Labels in the Bypass Tray 
1. Remove all paper from the tray. 
2. Load labels in the bypass tray, face up, with the top edge of the page feeding into the printer only. 
3. Adjust the width guides until they touch the edges of the paper. 
4. At the control panel, for Paper Settings, touch Size. 
5. Scroll through the list, then touch Custom. 
6. Specify the width and length, then touch OK. 
7. Touch Type, then touch Labels. 
8. Touch Confirm. 
9. At your computer, in the Printing Preferences of the print driver, click the Printing Options tab. 
10. For Paper Type, select Labels. 
 

Glossy Cardstock 

You can print Lightweight Glossy Cardstock and Glossy Cardstock up to 220 g/m² from any tray. 
 

Guidelines for Printing on Glossy Cardstock 
• Do not open sealed packages of glossy cardstock until you are ready to load them into the printer. 
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until 

ready to use. 
• Remove all other paper from the tray before loading glossy cardstock. 
• Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in 

the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to 

curl and jam in the printer. 
• In the print driver software, select the desired glossy cardstock type or select the tray loaded with 

the desired paper. 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected to an 
active network. Make sure that you have the correct print driver software installed on your computer. For 
details, see Installing the Software on page 47. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 

Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
 

See also: 
Loading Paper on page 58 
Selecting Printing Options on page 73 
Printing on Both Sides of the Paper on page 80 
Printing on Special Paper on page 66 
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Selecting Printing Options 

This section includes: 
• Print Driver Help................................................................................................................................................................ 73 
• Windows Printing Options ............................................................................................................................................ 74 
• Macintosh Printing Options ......................................................................................................................................... 75 
• Linux Printing Options .................................................................................................................................................... 76 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences 
become the default setting. Printing options that are set from within the software application are 
temporary. The application and the computer do not save the settings after the application is closed. 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

• Search provides a field where you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
− For Windows Server 2003 and later, click Start > Settings > Printers. 
− For Windows 7, click Start > Devices and Printers. 
− For Windows 8, click Control Panel > Devices and Printers. 

Note: If the Control Panel icon does not appear on the desktop, right-click on the desktop, then 
select Personalize > Control Panel Home > Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, you can change the Printing Preferences before 
sending the job to the printer. For example, if you want the highest print quality when you print a 
document, in Printing Preferences, select High Resolution, then submit the print job. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P. 
2. To open the Properties window, select your printer, then click the Properties or Preferences button. 

The title of the button varies depending on your application. 
3. Click a tab in the Properties window, then make selections. 
4. To save your selections and close the Properties window, click OK. 
5. To send the job to the printer, click OK. 
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Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select the printer, then click Properties. Click the tabs in the Properties window, then select the 

desired settings. 
3. To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the 

window, then click Save As. 
4. Type a name for the set of printing options, then to save the set of options in the Saved Settings list, 

click OK. 
5. To print using these options, select the name from the list. 
 

Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
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Linux Printing Options 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 
 

Printing from a Linux Workstation 

To print from a Linux workstation: 
1. Create a print queue. 
2. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CTRL+P. 
3. Select the target print queue. 
4. Close the Print dialog box 
5. In the Xerox® GUI print driver, select the available printer features. 
6. Click Print. 

The Xerox® print driver accepts job ticket settings files that select additional settings or features. 
You can also submit print requests through the command line using lp/lpr. 

To create a job ticket using the Xerox® GUI print driver: 
1. Open the Xerox® GUI print driver. 
2. Select the desired options. 
3. Click Save As, then store the job ticket in a public location, such as /tmp. 

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job 
ticket. You can specify the information on the command line. 

To create a job ticket using the command line: 
1. On the command line, as the root user, type xeroxprtmgr. 
2. Select the desired options. 
3. Click Save As, then store the job ticket in a public location, such as /tmp. 

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job 
ticket. You can specify the information on the command line. 

The following commands are examples of how to print using a job ticket: 
• lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File} 
• lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile 
• lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile 
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Managing Jobs 

This section includes: 
• Managing Jobs at the Control Panel ........................................................................................................................ 77 
• Managing Secure and Held Print Jobs ..................................................................................................................... 78 
• Managing Jobs in Xerox® CentreWare® Internet Services ............................................................................... 79 
 

Managing Jobs at the Control Panel 

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. For details, see Printing 
Special Job Types on page 91. 

To pause printing: 
1. At the control panel, press the Interrupt button. The printer continues to print while it determines 

the best place to pause the spooled print job. 
2. To resume printing, press the Interrupt button again. 

To pause the print job with the option to delete it: 
1. At the control panel, press the Interrupt button. 
2. Touch the job required. 
3. Do one of the following: 

− To delete the print job, touch Delete. 
− To resume the print job, touch Resume. 

To view active, secure, or completed jobs: 
1. At the control panel, press the Job Status button. 
2. To see a list of specific job types, touch a tab. 

− To view jobs that are in process or waiting to process, touch the Active Jobs tab. 
− To view Secure Print jobs, touch the Secure Print Jobs, or My Secure Jobs tab. Touch the 

folder, enter the passcode number using the keypad, then touch OK. 
− To view completed jobs, touch the Completed Jobs tab. 

3. To refine the list, use the drop-down menu. 
4. To see details about a job, touch the job. 
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To delete a job: 
1. At the control panel, press the Job Status button. 
2. From any of the job type tabs, touch the job. 
3. Touch Delete. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a secure print job. 

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs 
stored in printer folders. You can select and print jobs from any of the lists. To print the job, see Printing 
Special Job Types on page 91. 

To view saved jobs: 
1. Press the Services Home button, then touch Print From. 
2. Touch Saved Jobs. 
3. To view the saved jobs, touch a folder. 
4. To see details about a job, touch the job. 
 

Managing Secure and Held Print Jobs 

When you send a secure print job, the job is held until you release it by typing a passcode at the control 
panel. 

To view a list of secure print jobs: 
1. At the printer control panel, press the Job Status button. 
2. Touch Held Print Jobs or Secure Print Jobs, then select a folder. For details, see Secure Print on 

page 91. 

Note: Only the user that sent the job or the system administrator can delete a secure print job. 

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held 
until you release it. For details, see Releasing Held Print Jobs. 

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a 
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window 
using LPR, Port 9100, or from the Jobs tab in Xerox® CentreWare® Internet Services. 

To view a list of the unidentified jobs and release them: 
1. Touch the Unidentified Print Jobs tab. 
2. Do one of the following: 

− To release a held job, touch the job, then touch Print. 
− To release all held jobs, touch Print All. 

A print job can be held by the printer when it is unable to complete a print job. For example, it needs 
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. 
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Managing Jobs in Xerox® CentreWare® Internet Services 

You can view a list of active jobs and delete print jobs from the Active Jobs list in Xerox® CentreWare® 
Internet Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in Xerox® 
CentreWare® Internet Services. 
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Printing Features 

This section includes: 
• Printing on Both Sides of the Paper .......................................................................................................................... 80 
• Selecting Paper Options for Printing ......................................................................................................................... 81 
• Printing Multiple Pages to a Single Sheet ............................................................................................................... 81 
• Printing Booklets .............................................................................................................................................................. 82 
• Print Quality ....................................................................................................................................................................... 82 
• Using Image Options...................................................................................................................................................... 83 
• Using Special Pages ........................................................................................................................................................ 84 
• Scaling .................................................................................................................................................................................. 86 
• Printing Watermarks ....................................................................................................................................................... 87 
• Printing Watermarks ....................................................................................................................................................... 88 
• Printing Mirror Images ................................................................................................................................................... 90 
• Creating and Saving Custom Sizes ............................................................................................................................ 90 
• Selecting Job Completion Notification for Windows ......................................................................................... 90 
 

Printing on Both Sides of the Paper 

Paper Types for Automatic 2-Sided Printing 

The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided 
document, verify that the paper type and weight are supported. For details, see Supported Paper Types 
and Weights for Automatic 2-Sided Printing on page 57. 
 

Printing a 2-Sided Document 

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings 
for portrait or landscape orientation from the application for printing the document. 
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2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 
 

Portrait Landscape 

 

 

 

 

 

 

 

 
Portrait 
2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
2-Sided Print 

Landscape 
2-Sided Print, Flip on Short 
Edge 

  
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout 
is on the Document Options tab. 
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Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting 

compensates for the thickness of the folded paper, which can cause the page images to shift 
outward slightly when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 

 

 
 

 
 

Print Quality 

Print-quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• High-Resolution print-quality mode: 2400 x 600 dpi 
• Toner Saver print-quality mode 

− This mode reduces the amount of toner used for print jobs. 
− You can use this feature for draft quality output. 
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Using Image Options 

The Image Options control the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each 
system has standard modes of color control for normal use and custom color options for the more 
advanced users. Image Options are on the Image Options tab of the Properties window. There, they are 
divided into Color Correction, Color By Words, and Color Adjustments tabs. For details on accessing the 
Properties window, see Printing Overview on page 72. 

The Color Correction tab provides standard color modes. 
• Xerox Black and White: This feature converts all color in the document to black and white or 

shades of gray. 
• Xerox Automatic Color: This feature applies the best color correction to text, graphics, and images. 

Xerox recommends this setting. 
• Color Correction: Provides a selection of commercial press, spot color, CIE, and gray image 

simulations to match your document color. This tab also provides a Custom Automatic Color option 
for advanced color corrections based on RGB Color, CMYK Color, Spot Color, CIE Color, or Gray. 

The two remaining tabs provide additional ways of adjusting the colors for more specific color 
requirements. 

The Color By Words tab provides a three-step process for defining custom color correction. By making a 
selection from each of the three fields, you create a sentence for controlling the color characteristics of 
the document. You can create several sentences to more precisely control the color content of the 
document. As you create a Color By Words sentence, it appears in the window below the selection fields. 
The sentence structure is made of three parts: 
• What Color to Change?: Provides a list to select a color or range of colors to adjust, such as All 

Foliage-Green Colors. 
• How Much Change?: Lets you select how much effect to make to the selected color. 
• What Type of Change?: Lets you select the type of change, such as Vivid, from a list. 

The Color Adjustments tab provides a set of six sliders for adjusting the individual components of the 
selected colors. You can use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and 
yellow components of the color. 
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Using Special Pages 

The Special Pages options control how covers, inserts, and exception pages are added to your printed 
document. 

For details on accessing the Properties window, see Printing Overview on page 72. 
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages 
that are different from the source used for the body of a document. For example, you can use your 
company letterhead for the first page of a document. You can also use heavyweight paper for the first 
and last pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

Select one of these options for printing cover pages: 
• No Covers does not print cover pages. No cover pages are added to the document. 
• Front Only prints the first page on paper from the specified tray. 
• Back Only prints the back page on paper from the specified tray. 
• Front and Back: Same prints the front and back cover pages from the same tray. 
• Front and Back: Different prints the front and back cover pages from different trays. 

After making a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side 
two, or both sides of the cover pages. 
 
 

Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates 
sections, or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options: Provides the options to place an insert After Page X, where X is the specified page, 

or Before Page 1. 
• Quantity: Specifies the number of pages to insert at each location. 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. To specify a 
different paper size, color, or type, for Paper, click the arrow, then select an option. 

• Job Setting: Displays the attributes of the paper for the remainder of the job. 
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Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages: Specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper: Displays the default size, color, and type of paper selected in Use Job Settings. 
• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an 

option: 
− 1-Sided Print prints the exception pages on one side only. 
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box. 

• Job Setting: Displays the attributes of the paper for the remainder of the job. 

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 

 



Printing 

 

86 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Scaling 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. In 
Windows, you can find the Scale Options in the print driver on the Printing Options tab. 
 

50% 100% 200% 

   
 

1. To access Scaling Options, to the right of the Paper field, click the arrow, then select Other Size > 
Advanced Paper Size. 

2. Select an option. 
− No Scaling: You can use this option to retain the original image size. 
− Automatically Scale: You can use this option to change the print from one standard paper size 

to another. The Original Document Size is scaled to fit on the selected output paper size shown 
in the Output Paper Size field. 

− Manually Scale: You can use this option to change the output print size by a specified 
percentage. 
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Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

 
Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• Watermarks are not supported for some print drivers when booklet is selected or when more 
than one page is printed on a sheet of paper. 

Using the watermark options, you can do the following: 
• Create a watermark or edit an existing watermark using the Watermark Editor: 

− A Text Watermark uses the characters typed in the Text field as the watermark. You can create 
a text watermark to print on a document. Select options such as font size, font type, font color, 
and angle. 

− A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or 
.jpg format. You can create a picture watermark to print on a document, and select options 
including size and position on the page. 

− A Time Stamp Watermark uses a time stamp as the watermark. You can create a time stamp 
watermark to print on a document. Time stamp elements include the day, date, time, and time 
zone. 

• Place a watermark on the first page or on every page in a document. 
• Print a watermark in the foreground or background or blend it with the print job. 
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To print a Watermark: 
1. Click Document Options > Watermark. 
2. From the Watermark menu, select the watermark. 
3. Click Layering, then select how to print the watermark: 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend combines the watermark with the text and graphics in the document. A blended 

watermark is translucent, so you can see both the watermark and the document content. 
− Print in Foreground prints the watermark over the text and graphics in the document. 

4. Click Pages, then select the pages on which to print the watermark: 
− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

5. Click OK. 
 

Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

 
Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• Watermarks are not supported for some print drivers when booklet is selected or when more 
than one page is printed on a sheet of paper. 
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Using the watermark options, you can do the following: 
• Create a watermark or edit an existing watermark using the Watermark Editor: 

− A Text Watermark uses the characters typed in the Text field as the watermark. You can create 
a text watermark to print on a document. Select options such as font size, font type, font color, 
and angle. 

− A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or 
.jpg format. You can create a picture watermark to print on a document, and select options 
including size and position on the page. 

− A Time Stamp Watermark uses a time stamp as the watermark. You can create a time stamp 
watermark to print on a document. Time stamp elements include the day, date, time, and time 
zone. 

• Place a watermark on the first page or on every page in a document. 
• Print a watermark in the foreground or background or blend it with the print job. 

To print a watermark: 
1. Click Document Options > Watermark. 
2. From the Watermark menu, select the watermark. 
3. Click Layering, then select how to print the watermark: 

− Print in Background: This option prints the watermark behind the text and graphics in the 
document. 

− Blend: This option combines the watermark with the text and graphics in the document. A 
blended watermark is translucent, so you can see both the watermark and the document 
content. 

− Print in Foreground: This option prints the watermark over the text and graphics in the 
document. 

4. Click Pages, then select the pages on which to print the watermark: 
− Print on Page 1 Only: This option prints the watermark only on the first page of the document. 
− Print on All Pages: This option prints the watermark on all pages of your document. 

5. Click OK. 
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Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
 

Creating and Saving Custom Sizes 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. For paper sizes that are supported for 
each tray, see Supported Custom Paper Sizes on page 54. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab. 
2. For Paper, click the arrow, then select Other Size > Advanced Paper Size > Output Paper Size > 

New. 
3. In the New Custom Paper Size window, enter the height and width of the new size. 
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, 

then select Inches or Millimeters. 
5. To save, in the Name field, type a title for the new size, then click OK. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Page Setup. 
2. Click Paper Sizes, then select Manage Custom Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. At the top of the window, double-click My Custom Size, then type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click Print Margins, then select the printer from the list. Or set the top, bottom, right, and left 

margins. 
7. To save the settings, click OK. 
 

Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 

Note: This feature is available on a computer printing to a network printer. 

To be notified when your print job completes: 
1. In the print driver, click the Advanced tab. 
2. Click Notification > Notify for Completed Jobs > Enabled. 
3. Click OK. 
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Printing Special Job Types 

This section includes: 
• Secure Print ........................................................................................................................................................................ 91 
• Sample Set .......................................................................................................................................................................... 92 
• Delay Print .......................................................................................................................................................................... 93 
• Saved Job ............................................................................................................................................................................ 94 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. 

Select special job types in the print driver from the Printing Options tab. 
 

Secure Print 

Secure print allows you to associate a 4–10 digit passcode with a print job when sending it to the printer. 
The job is held at the printer until you enter the passcode at the control panel. 

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences 
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If 
you must use a different passcode, you can override it in the application print driver. 
 

Sending a Secure Print Job 
1. On the Printing Options tab, from the Job Type list, select Secure Print. 
2. Type a 4–10 digit passcode for the Secure Print job. 
3. In the Confirm Passcode field, type the passcode again. 

Notes: 

• If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode 
Required window. You can use the passcode supplied by the printer, or you can type your own 
passcode to use in the Secure Print window. 

• The passcode is associated with your user name. After you set a passcode, it becomes the 
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset 
the passcode at any time from any window that contains the passcode. 

4. Click OK. 
5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 
6. Select an option for 2-sided printing. 
7. Select a print-quality mode. 
8. Select another tab or click OK. 
9. To send the job to the printer, in the Print window, select the number of copies to print, then click 

OK or Print. 
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Releasing a Secure Print 
1. At the control panel, press the Job Status button. 
2. Touch Held Print Jobs or Secure Print Jobs, then select a folder. For details, see Secure Print on 

page 91. 
3. Use the keypad to enter the passcode that you assigned to the print job, then touch OK. 
4. Touch the corresponding print job in the list, then touch Print. 
 

Deleting a Secure Print 
1. At the control panel, press the Job Status button. 
2. Touch Held Print Jobs or Secure Print Jobs, then select a folder. For details, see Secure Print on 

page 91. 
3. Use the keypad to enter the passcode that you assigned to the print job, then touch OK. 
4. Touch the corresponding print job in the list, then touch Delete. 
 

Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the 
remaining copies at the printer. After you review the sample copy, you can select the job name from the 
printer control panel to print the additional copies. 
 

Sending a Sample Set Print Job 
1. On the Printing Options tab, from the Job Type list, select Sample Set. 
2. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 
3. Select an option for 2-sided printing. 
4. Select a print-quality mode. 
5. Select another tab or click OK. 
6. To send the job to the printer, in the Print window, select the number of copies to print, then click 

OK or Print. 
A sample copy prints immediately. The sample copy is not counted as part of the print job. 

7. After reviewing the copy, use the printer control panel to print or delete the remaining copies. 

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set 
Sample Set as your default Job Type. 

8. To print the job, select it from the job list on the printer control panel. 
9. Press OK. 
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Releasing the Remaining Prints After Printing a Sample Set 
1. At the control panel, touch Job Status. 
2. Touch Held Print Jobs or Active Jobs, then select a folder. 
3. Touch the corresponding print job in the list. 
4. Touch Print. 

The remainder of the job prints, then the printer deletes the job from the printer hard drive. 
 

Delay Print 

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at 
which you would like the job to print. If the time you enter is earlier than the time that you submit the 
print job, it prints on the following day. The Delayed Print default time is midnight. 
 

Sending a Delay Print Job 
1. On the Printing Options tab, from the Job Type list, select Delay Print. 
2. In the Delay Print window, select the Tab key to move from the hour section to the minutes section. 

To select the time to send the print job, click the arrow buttons. 
− For a 12-hour time format, type the hour (1–12), minutes (00–59), then select A.M. or P.M. To 

toggle between A.M. and P.M., click A.M. or P.M., then use the Up arrow or Down arrow 
buttons. 

− For a 24-hour time format, type the hour (1–23) and the minutes (00–59). 

Note: The regional settings on your computer determine the time format. 

3. Click OK. 
4. Select other desired printing options and click OK. 
5. Click OK or Print. 

Note: To print the job after you send it but before the scheduled time, release the job at the printer 
control panel. 
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Saved Job 

Saved Job or Store File in Folder stores a public or private job in the printer and prints the job as 
requested at the printer control panel. This option is useful for documents that you print frequently. You 
can assign a passcode to a private job to prevent unauthorized printing. 

To print saved jobs, see Printing from Saved Jobs. 
 

Sending a Public Saved Job 
1. On the Printing Options tab, from the Job Type list, select Saved Job. 
2. In the Saved Job window, for Job Name, do one of the following: 

− Type a name for the job. 
− Click the arrow to the right of the field and select a name from the list. 
− Click the arrow to the right of the field and select Use Document Name to use the name of the 

document. 

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted 
automatically from the list. To remove names from the list other than the selected name, select 
Clear List. 

3. In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the 
following: 
− Type the name of the destination folder. 
− Click the arrow to the right of the field, then select a folder name from the list. 
− Click the arrow to the right of the field, then select Default Public Folder. 

4. To print the job now and also save the job, select the Print and Save check box. 
5. Select Public. 
6. Click OK. 
7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 
8. Select options for the print job: 

− Select an option for 2-sided printing. 
− Select a print-quality mode. 

9. Select another tab or click OK. 
10. To send the job to the printer, in the Print window, select the number of copies to print, then click 

OK or Print. 
A sample copy prints immediately. The sample copy is not counted as part of the print job. 
After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs. 
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Sending a Private Saved Job 
1. On the Printing Options tab, from the Job Type list, select Saved Job. 
2. In the Saved Job window, for Job Name, do one of the following: 

− Type a name for the job. 
− Click the arrow to the right of the field and select a name from the list. 
− Click the arrow to the right of the field and select Use Document Name to use the name of the 

document. 

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted 
automatically from the list. To remove names from the list other than the selected name, select 
Clear List. 

3. In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the 
following: 
− Type the name of the destination folder. 
− Click the arrow to the right of the field, then select a folder name from the list. 
− Click the arrow to the right of the field, then select Default Public Folder. 

4. To print the job now and also save the job, select the Print and Save check box. 
5. To store your job at the printer, select Private. 
6. In the Passcode field, type a passcode. The passcode is associated with your user name. After you 

set a passcode, it becomes the default passcode for any print job that requires a passcode on all 
Xerox® printers. You can reset the passcode at any time from any window that contains the 
passcode. 

7. In the Confirm Passcode field, type the passcode again. 
8. Click OK. 
9. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 
10. Select options for the print job: 

− Select an option for 2-sided printing. 
− Select a print-quality mode. 

11. Select another tab or click OK. 
12. To send the job to the printer, in the Print window, select the number of copies to print, then click 

OK or Print. 
After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs. 
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Held Print Jobs 

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds. 
If you send a sample job, the first copy of the job prints and the rest of the copies hold until you release 
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is 
held until you release it. 
 

Releasing Held Print Jobs 
1. At the control panel, press the Job Status button. 
2. Touch Held Print Jobs or Secure Print Jobs, then select a folder. For details, see Secure Print on 

page 91. 
3. To determine why a job was held, touch the job, then touch Details. 
4. Do one of the following: 

− To release a held job, touch the job, then touch Print. 
− To release all held jobs, touch Print All. 
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Print From 

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB 
Flash drive. 
 

Printing from a USB Flash Drive 

You can print .pdf, .tiff, and .xps files directly from a USB Flash drive. 

Notes: 

• If USB ports are disabled, you cannot use a USB card reader for authentication, update the 
software, or print from a USB Flash drive. 

• The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC6655docs. 

To print from a USB Flash drive: 
1. Insert your USB Flash drive in a USB port on the printer. The Print from USB window appears. 

The list at the bottom of the window displays the folders and printable files on the USB Flash drive. 
2. To scroll through the list and locate the printable file, next to the list, use the arrows. 

If the print file is in a folder, to open the folder, touch the name. 
3. Touch the name of the printable file. 
4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 

finishing options. 
5. Press the green Start button. 
6. To go back to the last screen, touch Back. 
7. To look for other folders and printable files, touch Browse. 
 

Printing from Saved Jobs 

To print from saved jobs: 
1. At the control panel, press the Services Home button, then touch Print From. 
2. Select Saved Jobs, then touch the name of the folder containing the saved job. 
3. Touch the name of the saved job that you want to print. 

Note: To print a private saved job, touch the name of the job, then enter the passcode. 

4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 
finishing options. 

5. Press the green Start button. 
6. After the job prints, to return to the list of saved jobs, touch Browse. 

To return to the list of folders, touch Back. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Printing from Mailbox 

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive. 

To print from a mailbox: 
1. At the control panel, press the Services Home button, then touch Print From. 
2. Select Mailbox, then touch the name of the folder containing the document. 

Note: If Mailbox is not displayed, use Xerox® CentreWare® Internet Services to enable the Scan to 
Mailbox and Print From Mailbox features. Then create a scan to mailbox folder. For details, see the 
System Administrator Guide at www.xerox.com/office/WC6655docs. 

3. Touch the name of the document that you want to print. 
4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 

finishing options. 
5. Press the green Start button. 

After the job prints, to return to the list of documents in the mailbox, touch Browse. 
To return to the list of folders, touch Back. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Printing from Xerox® CentreWare® Internet Services 

You can print .pdf, .ps, .pcl, and .xps files directly from Xerox® CentreWare® Internet Services without 
having to open another application or the print driver. The files can be stored on a local computer hard 
drive, mass storage device, or network drive. 

To print from Xerox® CentreWare® Internet Services: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 30. 

2. In Xerox® CentreWare® Internet Services, click the Print tab. 
3. To select the file from a local network or remote location, click Browse, select the file, then click 

Open. 
4. For Printing, select the desired options for the job. 

− Normal Print prints a job immediately. 
− Secure Print prints a job after you enter your passcode at the printer control panel. 
− Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining 

copies at the printer. 
− Save Job for Reprint saves a print job in a folder on the print server for future printing. You can 

specify a job name and folder. 
− Delay Print prints a job at a specified time up to 24 hours from the original job submission. 

5. If Accounting is enabled, enter your User ID and account information. 
6. Click Submit Job. 

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation 
message to appear before you close this page. 
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• Basic Copying .................................................................................................................................................................. 102 
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Basic Copying 

1. To clear previous settings, press the yellow Clear All button on the control panel. 
2. Load your original documents: 

− Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Copy. 
4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of 

copies appears in the upper right corner of the touch screen. 
 

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button, 
then re-enter the number. 

 

5. Change the copy settings as needed. For details, see Selecting Copy Settings on page 104. 
6. Press the green Start button. 
 

Notes: 

• To pause or cancel a copy job, press the red Stop button on the control panel. 
• To interrupt a copy job, press the Interrupt button on the control panel. 
• On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to cancel 

the job completely. 
  
 

Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accommodates original 
sizes up to 216 x 356 mm (8.5 x 14 in.). 
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Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). 

To copy or scan the following types of originals, use the document glass rather than the duplex 
automatic document feeder. 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper such as cloth or metal 
• Envelopes 
• Books 
 

Document Feeder 

 

 

• Insert originals face up, with page one on top. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against the 

originals. 
• The document feeder supports paper weights 

of 50–125 g/m² for 1-sided pages, and 
60–125 g/m² for 2-sided pages. 

• The document feeder supports paper sizes 
from 139.7 x 139.7 mm (5.5 x 5.5 in.) through 
215.9 x 355.6 mm (8.5 x 14 in.). 

• The maximum document feeder capacity is 
approximately 60 sheets of 80 g/m² paper. 

 
 

Duplex Automatic Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first. 
• Only place loose sheets of paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the originals. 
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry. 
• Do not load originals above the MAX fill line. 
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Selecting Copy Settings 

This section includes: 
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• Advanced Copying ......................................................................................................................................................... 127 
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Basic Settings 

This section includes: 
• Selecting the Number of Copies ............................................................................................................................... 105 
• Selecting Color or Black and White Copies ........................................................................................................... 106 
• Reducing or Enlarging the Image ............................................................................................................................ 107 
• Selecting the Paper Tray ............................................................................................................................................. 108 
• Selecting 2-Sided Copy Options ............................................................................................................................... 108 
• Selecting Collated Copies ........................................................................................................................................... 108 
• Selecting Uncollated Copies ...................................................................................................................................... 109 
 

Selecting the Number of Copies 

You can enter up to 9999 copies using the keypad on the touch screen or the control panel. 

To enter the number of copies using the control panel alphanumeric keypad: 
1. Press the Services Home button, then touch Copy. 
2. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of 

copies appears in the upper right corner of the touch screen. 
3. To correct the number of copies entered using the alphanumeric keypad, press the C button, then 

re-enter the number. 

To enter the number of copies using the touch screen keypad: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Job Assembly tab, then touch Quantity. 
3. To enter the number of copies, use the keypad on the touch screen. To delete an incorrect entry, 

touch the X backspace key that appears in the entry field. 
4. Touch OK. The number of copies appears in the upper right corner of the touch screen. 
 



Copying 

 

106 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color, a single color, or in black and 
white. 

To select the output color: 
1. Press the Services Home button, then touch Copy. 
2. For Output Color, select an option. 

− Color: This option copies in full color output using all four printing colors, cyan, magenta, 
yellow, and black. 

− Black and White: This option copies in black and white only. Colors in the original document 
are converted to shades of gray. 

− More: This option provides an additional choice. 
• Single Color: This option copies in shades of a single color. In the color palette window, 

select a color. 
3. Touch OK. 
 



Copying 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 107 
 User Guide 
 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. Press the Services Home button, then touch Copy. 
2. For Reduce/Enlarge, touch an option. 

− To use the alphanumeric keypad to reduce or enlarge the percentage, touch the current value 
displayed, then type a value. 

− To reduce or enlarge the percentage incrementally, touch the arrows. 
3. For additional options, touch Reduce/Enlarge. 

a. To reduce or enlarge proportionally, touch Proportional %. 
• To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
• To use the alphanumeric keypad to reduce or enlarge the percentage, touch the current 

value displayed, then type a value. 
• Preset: This option allows you to select from a list of preset values. For additional options, 

touch More. 
• Auto %: This option allows the device automatically to select the best ratio to reduce or 

enlarge the original to fit onto the selected paper size. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

• To center the image on the page, select the Auto Center check box. 
b. To reduce or enlarge the width and length of the image by different percentages, touch 

Independent %. 
• Width (X): This option allows you to reduce or enlarge the width of the image 

incrementally using the alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Length (Y): This option allows you to reduce or enlarge the length of the image 

incrementally using the alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Preset (Y / X): This option allows you to select from a list of preset values. For additional 

options, touch More. 
• 100 / 100%: This option keeps your output image the same size as your original image. 
• Auto Independent %: The device selects a separate reduction or enlargement percentage 

automatically for the width and the length of the image to make it fit onto the selected 
paper size. The image is not reduced or enlarged proportionally. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

• To center the image on the page, select the Auto Center check box. 
4. Touch OK. 
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Selecting the Paper Tray 

To make copies on Letterhead, colored paper, or different paper sizes, you load the desired paper into 
any tray, then select the tray as the source for your copy job. 

To select the tray to use for copies: 
1. Press the Services Home button, then touch Copy. 
2. For Paper Supply, touch the desired tray. 
3. If the desired tray does not appear, touch View Details. 
4. Touch the desired tray, then touch OK. 
 

Selecting 2-Sided Copy Options 

Use the document feeder or the document glass to copy one or both sides of a 2-sided original. 

To select 2-sided copy options: 
1. Press the Services Home button, then touch Copy. 
2. Under 2-Sided Copying, select one of the following: 

− 1->1 Sided scans only one side of the originals and produces 1-sided copies. 
− 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the 

second sides, touch Rotate Side 2. 
− 2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second 

sides, touch Rotate Side 2. 
− 2->1 Sided scans both sides of the originals and produces 1-sided copies. 

3. Press the green Start button. 
− The document feeder automatically copies both sides of the 2-sided original. 
− A message appears on the control panel when it is time to place the next original on the 

document glass. 
 

Selecting Collated Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

To select collated copies: 
1. Press the Services Home button, then touch Copy. 
2. For Collation, touch Collated. 
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Selecting Uncollated Copies 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select uncollated copies: 
1. Press the Services Home button, then touch Copy. 
2. For Collation, touch Uncollated. 
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Image Quality Settings 

This section includes: 
• Specifying the Original Type ..................................................................................................................................... 110 
• Adjusting Brightness and Sharpness ...................................................................................................................... 110 
• Adjusting Saturation ..................................................................................................................................................... 110 
• Automatically Suppressing Background Variation ............................................................................................ 111 
• Adjusting the Contrast ................................................................................................................................................. 111 
• Selecting Color Effects ................................................................................................................................................. 111 
• Adjusting the Color Balance ...................................................................................................................................... 112 
 

Specifying the Original Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the original type: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Original Type. 
3. On the Original Type screen, select the setting that matches your original document best. 
4. Touch OK. 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Options. 
3. On the Image Options screen, adjust the sliders as needed: 

− Lighten/Darken: Lightens or darkens the image. 
− Sharpness: Sharpens or softens the image. 

4. Touch OK. 
 

Adjusting Saturation 

Adjusting the saturation makes the image colors more vivid or pastel. 

To adjust the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Saturation. 
3. Adjust the sliders as needed. 
4. Touch OK. 
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Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To change this setting: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or reduce the contrast of the copies: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. On the Image Enhancement screen, adjust the contrast: 

− Auto Contrast allows the printer to set the contrast automatically. 
− Manual Contrast allows you to adjust the contrast manually. To increase or decrease the 

contrast, move the Manual Contrast slider up or down. The middle position on the slider, 
Normal, does not change the contrast. 

4. Touch OK. 
 

Selecting Color Effects 

If you have a color original, you can adjust the color of the copy using preset color effects. For example, 
you can adjust colors to be brighter or cooler. 

To select a preset color effect: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Color Presets. 

Note: This feature is not available when Output Color is set to Black and White. 

3. On the Color Presets screen, touch the desired preset color effect. The sample images show how the 
colors are adjusted. 

4. Touch OK. 
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Adjusting the Color Balance 

If you have a color original, you can adjust the balance of the printing colors between cyan, magenta, 
yellow, and black before printing your copy. 

To adjust the color balance: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Color Balance. 

Note: This feature is not available when Output Color is set to Black and White. 

3. To adjust the density levels of all four colors: 
a. On the Color Balance screen, touch Basic Color. 
b. Move the sliders to adjust the level for each color. 

4. To adjust the highlight, midtone, and shadow density levels by color: 
a. On the Color Balance screen, touch Advanced Color. 
b. Touch the color you want to adjust. 
c. Move the sliders to adjust the levels for highlights, midtones, and shadows. 
d. Repeat the previous two steps for additional colors. 

5. Touch OK. 
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Layout Settings 

This section includes: 
• Specifying the Orientation of the Original ........................................................................................................... 113 
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• Inverting the Image ...................................................................................................................................................... 115 
 

Specifying the Orientation of the Original 

If you plan to have the copies automatically stapled, specify the orientation of the original. 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Original Orientation. 
3. On the Original Orientation screen, touch the desired orientation: 

− Portrait Originals and Landscape Originals refer to the images on the originals. 
− Upright Images and Sideways Images refer to the direction the originals are loaded in the 

document feeder. 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

4. Touch OK. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size. 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Original Size. 
3. On the Original Size screen, select an option: 

− Auto Detect: The printer detects the size of the original document. 
− Preset Scan Area: You can specify the area to scan when it matches a standard paper size. In 

the scrolling list, touch the desired paper size. 
− Custom Scan Area: You can specify the height and width of the area to scan. To specify an 

area, touch the Length (Y) and Width (X) arrows. 
4. Touch OK. 
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Selecting Book Copying 

When copying a book, magazine, or other bound document, you can copy either the left or right page 
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as 
a single image on one sheet of paper. 
 

Note: You must use the document glass to make copies from books, magazines, or other bound 
documents. Do not place bound originals in the document feeder. 

To set up book copying: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Book Copying. 
3. On the Book Copying screen, select an option: 

− Off copies both pages of an open book as one image on a single sheet of paper. 
− Both Pages copies the left and the right pages of an open book onto two sheets of paper. If 

Binding Edge Erase is required, touch the arrows to erase up to 50.8 mm (2 in.). 
− Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding 

Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.). 
− Right Page Only to copy only the right page of an open book on a single sheet of paper. If 

Binding Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.) 
4. Touch OK. 
 

Shifting the Image 

You can change the placement of an image on the copy page. This is useful if the image is smaller than 
the page size. Originals must be positioned as follows for image shift to work correctly: 
• Document Feeder: Position originals face up, long edge entering the feeder first. 
• Document Glass: Position originals face down, in the back-left corner of the document glass, long 

edge to the left. 

To change the placement of the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Image Shift. 
3. On the Image Shift screen, select an option: 

− Auto Center centers the image on the page. 
− Margin Shift allows you to specify the position of the image. To specify the amount of shift for 

Side 1, touch the Up/Down and Left/Right arrows. To specify the amount of shift for Side 2, 
touch the Up/Down and Left/Right arrows, or select Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch OK. 
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Erasing the Edges of Copies 

You can erase content from the edges of your copies by specifying the amount to erase on the right, left, 
top, and bottom edges. 

To erase edges on copies: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Edge Erase. 
3. On the Edge Erase screen, select an option: 

− All Edges erases all four edges by the same amount. To specify the amount to erase from the 
edge, touch the All Edges arrows. 

− Individual Edges specifies different amounts for the edges. To specify the amount to erase 
from each edge, touch Side 1, then touch the Left, Right, Top, and Bottom arrows. To specify 
the amount to erase from each edge, touch Side 2, then touch the Left, Right, Top, and 
Bottom arrows, or touch Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch OK. 
 

Inverting the Image 

You can invert your original, as a mirror image or as a negative image. You can use one or both of these 
options. 

To invert the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Invert Image. 
3. On the Invert Image screen, select an option: 

− Mirror Image reflects each image left to right on the page. 
− Negative Image reverses the black and white values. 

4. Touch OK. 
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• Repeating an Image ..................................................................................................................................................... 123 
 

Creating a Booklet 

The booklet feature reduces the original page images to fit two images on each side of the printed page. 
You can print copies in booklet format. 

Note: In this mode, the printer scans all of the originals before it prints the copies. 

To create a booklet: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Booklet Creation. 
3. On the Booklet Creation screen, touch On. 

If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the desired 
paper tray, then touch OK. 

4. To specify 2-sided originals: 
a. Touch Original Input. 
b. Touch 2-Sided Originals or 2-Sided, Rotate Side 2. 

5. To select a paper tray: 
a. Touch Paper Supply. 
b. Touch the desired tray. 
c. Touch OK. 

6. Touch OK. 
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Including Covers 

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight 
paper. The printer selects the paper from a different tray. The covers can be blank or printed. 

To select the type of covers and the tray to use for the cover paper: 
1. Press the Services Home button, then touch Copy. 
2. For Paper Supply, touch the tray that contains the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages. 
4. On the Special Pages screen, touch Covers. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

5. For Covers Options, select an option: 
− Front & Back Same: This option includes front and back covers from the same tray. 
− Front & Back Different: This option includes a front and a back cover from different trays. 
− Front Only: This option includes a front cover only. 
− Back Only: This option includes a back cover only. 

6. To specify printing options for the front or back covers, for Printing Options, touch the arrow, then 
select an option. 
− Blank Cover: This option inserts a blank cover. 
− Print on Side 1 Only: This option prints on the front side of the cover only. To rotate the image 

on side 2 by 180 degrees, touch Rotate Side 2. 
− Print on Side 2 Only: This option prints on the back side of the cover only. To rotate the image 

on side 2 by 180 degrees, touch Rotate Side 2. 
− Print on Both Sides: This option prints on both sides of the cover. 

7. For Paper Supply, touch the desired tray. Touch OK. 
8. Touch OK. The options that you select appear on the Special Pages screen. 
9. To edit or delete a special page entry, touch the entry in the list, then from the menu, touch the 

desired action. 
10. Touch OK. 
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Specifying Chapter Start Pagination 

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If 
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side 
of the paper. 

To set the start side of particular pages: 
1. Press the Services Home button, then touch Copy. 
2. For Paper Supply, touch the tray that contains the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages > Chapter Starts. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

4. On the Chapter Starts screen, touch Page Number, then use the alphanumeric keypad to enter the 
page number. 

5. For Start Chapter, select an option: 
− On Right Page: This option specifies the front side of the paper. 
− On Left Page: This option specifies the back side of the paper. 

6. Touch Add. That page is added to the list on the right side of the screen. 
7. To set other pages, repeat the three previous steps. 
8. Touch Close. The options that you select appear on the Special Pages screen. 
9. To edit or delete a special page entry, touch the entry in the list, then from the menu, touch the 

desired action. 
10. Touch OK. 
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Adding Inserts 

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify 
the tray containing the inserts. 

Note: Ensure that the paper used for the inserts is the same width as the paper used in the rest of the 
document. If you select Booklet Creation, inserts are not allowed. 

To add inserts: 
1. Press the Services Home button, then touch Copy. 
2. For Paper Supply, touch the tray that contains the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages > Inserts. 

If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the desired 
paper tray, then touch OK. 

4. To specify the number of sheets to insert, for Insert Quantity, touch the arrows. 
5. Touch Insert After Page, then to enter a page number, use the alphanumeric keypad. 
6. To specify the paper tray to use for the insert: 

a. Touch Paper Supply. 
b. Touch the desired tray. 
c. Touch OK. 

7. Touch Add. 
8. The insert appears in the list on the Inserts screen. 
9. To add additional inserts, repeat the four previous steps. 
10. Touch Close. The options that you select appear on the Special Pages screen. 
11. To edit or delete a special page entry, touch the entry in the list, then from the menu, touch the 

desired action. 
12. Touch OK. 
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Specifying Exception Pages 

You can print exception pages in a copy job that uses paper from a different tray. The paper that you 
use for the exception pages must be the same size as the paper that you use for the rest of the 
document. 

Notes: 
• If Booklet Creation is enabled, you cannot select this feature. 
• If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. 

To specify the exception pages: 
1. Press the Services Home button, then touch Copy. 
2. For Paper Supply, touch the tray that contains the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages > Exceptions. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

4. On the Exceptions screen, touch the beginning Page Number field. To enter the starting number 
value for the range of exception pages, use the alphanumeric keypad. 

5. Touch the ending Page Number field, then to enter the ending value range for the exception pages, 
use the alphanumeric keypad. 

Note: To specify a single page as an exception, enter that page number as the start and end of the 
range. 

6. To specify the paper to use for the exception pages: 
a. Touch Paper Supply. 
b. Touch the tray that contains paper to use for the exception pages. 
c. Touch OK. 

7. Touch Add. The exception pages appear on the Exception screen. 
8. Touch Close. The options that you select appear on the Special Pages screen. 
9. To edit or delete a special page entry, touch the entry in the list, then from the menu, touch the 

desired action. 
10. Touch OK. 
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Adding Annotations 

You can automatically add annotations such as page numbers and the date to your copies. 
 

Notes: 

• Annotations are not added to covers, tabs, inserts, or blank chapter start pages. 
• Annotations cannot be added if Booklet Creation is selected. 

To add annotations: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Annotations. 
3. To insert page numbers: 

a. On the Annotation screen, touch Page Numbers > On. 
b. Touch Apply To, then select an option. 
c. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the page 

number. 
d. Touch an arrow to position the page number in the header or footer. The sample page shows 

the location of the page number. 
e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
4. To insert a comment: 

a. Touch Comment > On. 
b. Touch Apply To, then select an option. 
c. Touch an existing comment in the list. 

Note: To create a comment, touch a blank row, use the touch screen keyboard to type the text, then 
touch OK. 

d. Touch an arrow to position the selected comment in the header or footer. The sample page 
shows the location of the comment. 

e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
5. To insert the current date: 

a. Touch Date > On. 
b. Touch Apply To, then select an option. 
c. Under Format, select a format for the date. 
d. Touch an arrow to position the date in the header or footer. The sample page shows the 

location of the date. 
e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
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6. To insert a Bates Stamp: 
a. Touch Bates Stamp > On. 
b. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the 

starting page number. Leading zeros can be included. 
c. Touch Apply To, then select an option. 
d. Under Stored Prefixes, touch an existing prefix in the list. 

Note: To create a prefix, touch a blank row, use the touch screen keyboard to type up to eight 
characters, then touch OK. 

e. Under Position, touch an arrow to position the Bates Stamp in the header or footer. The sample 
page shows the location of the Bates Stamp. 

f. Touch OK. 
g. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
7. Touch OK. 
 

Printing Multiple Pages Per Side 

You can copy a single page and have it print multiple times onto one or both sides of the paper. The 
printer reduces the pages proportionally to fit. 

Note: If Booklet Creation is enabled, you cannot select this feature. 

To print multiple original pages on a side: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Page Layout > Pages per Side. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

3. Touch the number of original pages for each side of the paper. To specify a different number: 
a. Touch Specify Rows & Columns. 
b. To change the number of rows, for Rows, touch the arrows, then select the desired number. 
c. To change the number of columns, for Columns, touch the arrows, then select the desired 

number. 
d. To rotate the pages, for Rotate Background, select the check box. 

Note: The right side of the screen displays a diagram of the image layout. 

4. Touch Original Orientation, then Portrait or Landscape. 
5. Touch OK. 
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Repeating an Image 

You can make multiple copies of an original image on one or both sides of the paper. This is useful for 
duplicating a small image. 

Note: If Booklet Creation is enabled, you cannot select this feature. 

To repeat an image on a sheet of paper: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Page Layout > Repeat Image. 

Note: If Paper Supply is set to Auto Paper Select, the Paper Conflict screen appears. Select the 
desired paper tray, then touch OK. 

3. Specify how many times the image repeats on the page: 
− To repeat the image 2 Times, 4 Times, or 6 Times on the page, select a preset option. 
− Specify Rows & Columns: This option allows you to determine the number of images. To enter 

the number of rows and columns, touch the Rows or Columns field, then use the alphanumeric 
keypad or touch the arrows. To rotate the paper, select the Rotate Background check box. 

− Auto Repeat: This option allows the printer to determine the maximum number of images that 
can fit on the paper size that is currently selected. 

4. Touch Original Orientation, then from the menu, select the orientation option desired. The sample 
page shows the image layout. 

5. Touch OK. 
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ID Card Copying 

This section includes: 
• Copying an ID Card ....................................................................................................................................................... 124 
• Selecting Color or Black and White Copies ........................................................................................................... 125 
• Reducing or Enlarging the Image ............................................................................................................................ 125 
• Selecting the Paper Tray ............................................................................................................................................. 126 
• Specifying the Original Type ..................................................................................................................................... 126 
• Lightening or Darkening ID Card Copies .............................................................................................................. 126 
• Automatically Suppressing Background Variation ............................................................................................ 126 
 

Copying an ID Card 

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied 
using the same location on the document glass. The printer stores both sides and prints them side by 
side on the paper. 

To copy an ID card: 
1. Press the Services Home button, then touch ID Card Copy. 
2. To enter the number of copies, use the keypad on the touch screen or the control panel. 
3. For Common Features, touch Edit. 

a. Verify the output color, paper supply, and reduce/enlarge settings. 
b. Change the settings as needed. 
c. Touch OK. 

4. For Front Side Features, touch Edit. 
a. Verify the original type, lighten/darken, and background suppression settings for side 1. 
b. Change the settings as needed. 
c. Touch OK. 

5. Lift the document cover. 
6. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left 

corner of the document glass. 
7. Press the green Start button, or touch Scan Front on the touch screen. 

The document scans and the Scan Back button appears on the touch screen. 
8. Lift the document cover. 
9. Turn over the document and position it in the upper left corner of the document glass. 
10. For Back Side Features, touch Edit. 

a. Verify the original type, lighten/darken, and background suppression settings for side 2. 
b. Change the settings as needed. 
c. Touch OK. 

11. Press the green Start button, or touch Scan Back on the touch screen. 
12. Lift the document cover and remove the ID card or document. 
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Selecting Color or Black and White Copies 

If the original document contains color, you can create color or black and white copies. 

To select the output color: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Common Features, touch Edit. 
3. For Output Color, touch an option. 

− Color: This option copies in full color output using all four printing colors, cyan, magenta, 
yellow, and black. 

− Black & White: Produces copies in black and white only. Colors in the original are converted to 
shades of gray. 

4. Touch OK. 
 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Common Features, touch Edit. 
3. For Reduce/Enlarge, touch an option. 

− To use the alphanumeric keypad to reduce or enlarge the percentage, touch the current value 
displayed, then type a value. 

− To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
− To select a preset image size, touch a button. For additional options, touch More. 

4. For additional options, touch More. 
a. To reduce or enlarge proportionally, touch Proportional %. 

• To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
• To use the alphanumeric keypad to reduce or enlarge the percentage, touch the current 

value displayed, then type a value. 
• Preset: This option allows you to select from a list of preset values. For additional options, 

touch More. 
b. To reduce or enlarge the width and length of the image by different percentages, touch 

Independent %. 
• Width (X): This option allows you to reduce or enlarge the width of the image 

incrementally using the alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Length (Y): This option allows you to reduce or enlarge the length of the image 

incrementally using the alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Preset (Y / X): This option allows you to select from a list of preset values. 

c. Touch OK. 
5. Touch OK. 
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Selecting the Paper Tray 

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper, special 
media, or different paper sizes. 

To select the tray to use for ID card copies: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Common Features, touch Edit. 
3. For Paper Supply, touch the desired tray. 
4. Touch OK. 
 

Specifying the Original Type 

You can use the Original Type option to specify the type of images to scan. The device uses this 
information to optimize the image quality settings and produce the best quality output. 

To specify the original type: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Front Side Features or Back Side Features, touch Edit. 
3. For Original Type, touch the content type for the original document. 
4. Touch OK. 
 

Lightening or Darkening ID Card Copies 

You can lighten or darken the copy for each side. Use the slider to lighten or darken the output for the 
first side. After the first side is complete, use the slider again to lighten or darken the second side. Both 
sides of the original are printed side by side, each using different lighten or darken settings. 

To adjust the image: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Front Side Features or Back Side Features, touch Edit. 
3. To lighten or darken the image, for Lighten/Darken, adjust the slider up or down. 
4. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To change Background Suppression: 
1. Press the Services Home button, then touch ID Card Copy. 
2. For Front Side Features or Back Side Features, touch Edit. 
3. For Background Suppression, touch Auto Suppression. 
4. Touch OK. 
 



Copying 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 127 
 User Guide 
 

Advanced Copying 

This section includes: 
• Building a Copy Job ....................................................................................................................................................... 127 
• Printing a Sample Copy ............................................................................................................................................... 128 
• Saving Copy Settings .................................................................................................................................................... 128 
• Retrieving Saved Copy Settings ................................................................................................................................ 128 
 

Building a Copy Job 

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy 
settings. Each segment of the job can have different copy settings. Once all the segments are 
programmed, scanned, and temporarily stored in the printer, the copy job prints. 

To build a copy job with multiple segments: 
1. Press the Services Home button, then touch Copy. 
2. Program and scan the first segment: 

a. Load the originals for the first segment. 
b. Select the required settings, such as layout adjustments, image quality, and options. 
c. Touch the Job Assembly tab, then touch Build Job > On. 
d. Touch Options. 
e. Select or clear the Display summary window between segments check box. 
f. Select or clear the Turn Build Job Off after Job is Submitted check box. 
g. Touch OK. 
h. Press the green Start button on the control panel. 

3. Sample or delete segments: 
a. To print a sample of the previous segment scanned, touch Sample Last Segment. 
b. To delete the previous segment scanned, touch Delete Last Segment. 

4. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Using the appropriate tabs, select the required settings. 
d. Press the green Start button to scan the originals for that segment. 

5. Repeat the previous step for each remaining segment. 
6. For Quantity for Final Job, to enter the number of copies, use the alphanumeric keypad. 
7. In the corner of the Build Job screen, touch Submit Job. 

To cancel the job, touch Delete All Segments. 
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Printing a Sample Copy 

The Sample Copy features allows you to print a test copy of a complex print job to inspect before you 
print multiple copies of the job. Once you inspect the job, you can print the or cancel the remaining 
copies. Sample copies do not count as part of the quantity selected. For example, if you select three 
copies, one sample copy prints, and the three other copies are held until you release them to print. The 
result is a total of four copies. 

To print a sample copy of your copy job: 
1. Press the Services Home button, then touch Copy. 
2. Touch the desired copy settings. 
3. Touch the Job Assembly tab, then touch Sample Job > On. 
4. Touch OK. 
5. On the control panel, press the green Start button. The sample copy prints. 
6. Print the remaining copies or delete the job. 

− To release and print the remaining copies of the job, touch Print. 
− If the sample copy is unsatisfactory, touch Delete. 

 

Saving Copy Settings 

To use a particular combination of copy settings for future copy jobs, you can save the settings with a 
name and retrieve them for later use. 

To save the current copy settings: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Job Assembly tab, then touch Save Current Settings. 
3. Using the touch screen keyboard, type a name for the saved settings. 
4. Touch OK. 
 

Retrieving Saved Copy Settings 

You can retrieve and use any previously saved copy settings for current jobs. 
 

Note: To save the copy settings with a name, see Saving Copy Settings on page 128. 

To retrieve saved settings: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Job Assembly tab, then touch Retrieve Saved Settings. 
3. Touch the desired saved setting. 
 

Note: To delete a saved setting, touch the setting, then touch Delete Settings. 
 

4. Touch Load Settings. The saved settings are loaded for the current copy job. 
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This chapter includes: 
• Basic Scanning ................................................................................................................................................................ 130 
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• Scanning to Network File Repositories ................................................................................................................... 136 
• Scanning to Your Home Directory ........................................................................................................................... 138 
• Setting Scan Options .................................................................................................................................................... 139 
• Scanning to a USB Flash Drive .................................................................................................................................. 145 
• Scanning to an Email Address ................................................................................................................................... 146 
• Scanning to a Destination .......................................................................................................................................... 151 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC6655docs. 

If the system administrator enables Remote Start in Xerox® CentreWare® Internet Services, you can scan 
images directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import, and store 
images from the printer. You can also scan directly from the printer to a computer using most 
TWAIN-compliant scanning applications. 
 

 7 Scanning 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Basic Scanning 

The Scanning feature provides several methods for scanning and storing an original document. The 
scanning procedure using your printer differs from that of desktop scanners. The printer is connected 
typically to a network rather than a single computer, so you select a destination for the scanned image 
at the printer. 

The printer supports the following scanning functions: 
• Scan documents and store images on the printer hard drive. 
• Scan original documents to a document repository on a network server. 
• Scan original documents to an email address. 
• Scan original documents to your home directory. 
• Scan original documents to a USB Flash drive. 
• Import scanned images into applications using TWAIN and WIA. 

To scan an image: 
1. On the control panel, press the yellow Clear All button to clear previous settings. 
2. Load your original documents: 

− Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Workflow Scanning. 
4. Touch Change, then for Pick a Workflow, select an option. 
5. To change any of the scan settings, on the Workflow Scanning screen, select options. 
6. Press the green Start button. 
 

Notes: 

• The printer must be connected to a network to retrieve a scan file remotely. 
• For details, see the Help in Xerox® CentreWare® Internet Services. 
• Print, copy, and fax jobs can print while you are scanning original documents or downloading 

files from the printer hard drive. 
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Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accommodates original 
sizes up to 216 x 356 mm (8.5 x 14 in.). 

 
 

Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). 

To copy or scan the following types of originals, use the document glass rather than the duplex 
automatic document feeder. 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper such as cloth or metal 
• Envelopes 
• Books 
 

Document Feeder 

 

 

• Insert originals face up, with page one on top. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against the 

originals. 
• The document feeder supports paper weights 

of 50–125 g/m² for 1-sided pages, and 
60–125 g/m² for 2-sided pages. 

• The document feeder supports paper sizes 
from 139.7 x 139.7 mm (5.5 x 5.5 in.) through 
215.9 x 355.6 mm (8.5 x 14 in.). 

• The maximum document feeder capacity is 
approximately 60 sheets of 80 g/m² paper. 
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Duplex Automatic Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first. 
• Only place loose sheets of paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the originals. 
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry. 
• Do not load originals above the MAX fill line. 
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Scanning to a Folder 

This section includes: 
• Scanning to the Public Folder .................................................................................................................................... 133 
• Scanning to a Private Folder ...................................................................................................................................... 134 
• Creating a Private Folder............................................................................................................................................. 134 
• Retrieving Scan Files ..................................................................................................................................................... 135 

Scanning to a folder is the simplest scanning method. When you scan an image at the printer, the scan 
file is stored in a folder on the internal hard drive. You then use Xerox® CentreWare® Internet Services to 
retrieve the stored scan file to your computer. 

The default settings create a 1-sided color portable document format (.pdf) file. You can change these 
settings using the printer control panel, or using Xerox® CentreWare® Internet Services at your computer. 
Control panel selections override the settings in Xerox® CentreWare® Internet Services. 
 

Scanning to the Public Folder 

The printer provides a public folder to store scanned images. You do not need a password to scan images 
to the public folder, or to retrieve them. All users can view scanned documents in the public folder. You 
can also create a password-protected private folder. For details, see Creating a Private Folder. 

To scan an image to the public folder: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch Change. 
4. From the Pick a Workflow window, select DEFAULT. 
5. To change any of the scan settings, on the Workflow Scanning screen, select options. 
6. Press the green Start button. The Job Progress screen appears, and the original is scanned. The 

printer stores the original on the hard drive. 
7. To move the file to your computer, use Xerox® CentreWare® Internet Services. For details, see 

Retrieving Scan Files on page 135. 
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Scanning to a Private Folder 

The system administrator creates private folders on the printer. Private folders can require a password. 
You can use Xerox® CentreWare® Internet Services to create your own private folders. For details, see 
Creating a Private Folder. 

To scan to a private folder: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch Change. 
4. From the Pick a Workflow screen, select a private folder. 
5. On the Mailbox Password screen, touch Enter Mailbox Password, then to enter the password, use 

the touch screen keyboard. 
6. Touch OK. 
7. Press the green Start button. 
 

Creating a Private Folder 

For you to create a private folder, the scan policy to allow additional folders to be created must be 
enabled. The system administrator can create a private folder at any time. For details, see the System 
Administrator Guide for your printer model. 

To create a private folder with a password: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer 
on page 30. 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 

Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, see the 
System Administrator Guide at www.xerox.com/office/WC6655docs. 

4. In the Scan to Mailbox section, click Create Folder. 
5. Click the Folder Name: field, then type a name for the folder. 
6. In the Folder Password field, type a password that adheres to the password rules. 
7. In the Confirm Folder Password field, type the password again. 
8. Click Apply. 

Your private folder appears in the folder list in Xerox® CentreWare® Internet Services and on the 
printer touch screen under Pick a Workflow. The contents are stored on the printer hard drive. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Retrieving Scan Files 

To retrieve your scanned images, use Xerox® CentreWare® Internet Services to copy the scan files from 
the printer to your computer. 

To retrieve your scan files: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 30. 

 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 
4. In the Scan to Mailbox section, click the folder containing the scan. 

Your scan file appears in the Folder Contents window. 
 

Notes: 

• For a password protected private folder, click the Folder Password field, type the password, then 
click OK. 

• If your image file does not appear, click Update View. 
 

5. Under Action, select an option, then click Go. 
− Download saves a copy of the file to your computer. When prompted, click Save, then navigate 

to the location on your computer to save the file. Open the file or close the dialog box. 
− Reprint prints the file without saving a copy of the file to your computer. 
− Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel 

to cancel the operation. 
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Scanning to Network File Repositories 

This section includes: 
• Scanning to a Predefined Network File Repository ........................................................................................... 136 
• Adding a Scan Destination ......................................................................................................................................... 137 

When using this feature, the images you scan are sent to a file repository on a network server. The 
system administrator configures the file repository settings. 

Using Xerox® CentreWare® Internet Services, you can add your own scan destinations to templates. 
 

Scanning to a Predefined Network File Repository 

To scan an image and send it to a predefined network file repository: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch Change. 
4. From the Pick a Workflow screen, select the template that the system administrator created. 

The template defines the scan settings as well as the destination of the image. 
5. To change any of the scan settings, on the Workflow Scanning screen, select options. 

For details, see Setting Scan Options on page 139. 
6. Press the green Start button. 
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Adding a Scan Destination 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Click the Scan tab. 
3. In the Display area, select Templates. 
4. Under Template Operations, click Create New Template. 
5. In the New Distribution Template area, under Add Destination to Template, click Enter a Scan 

Destination. 
6. Click the Friendly Name: field, then create a name for the template. 
7. Under Protocol, select an option. 
8. Configure the destination IP Address: Port number or Host Name: Port number. 
9. Enter the name of the destination folder as needed. In SMB, the destination folder is the shared 

folder. 
10. In Document Path, enter the name of the sub folder within the destination folder, then select a 

Filing Policy. 
11. Enter a valid login name and password. 

Note: Use the login name for the computer that holds the destination folder. The login name can 
include the domain name also, such as domain name\login name. 

12. Click Add. The template is stored on the printer hard drive. 
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Scanning to Your Home Directory 

The Scan to Home feature allows you to scan an image to your home directory. 

Note: To use the Scan to Home function, you must log in with a valid user name and passcode. For 
details, see Logging In on page 27. 

To scan an image to your home directory: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch Change. 
4. From the Pick a Workflow screen, select the template that the system administrator created. 
5. To change any of the scan settings, on the Workflow Scanning screen, select options. 
6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings. 
7. Press the green Start button. 
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Setting Scan Options 

This section includes: 
• Changing the Basic Scan Settings ........................................................................................................................... 140 
• Selecting Advanced Settings ..................................................................................................................................... 141 
• Selecting Layout Adjustments .................................................................................................................................. 142 
• Selecting Filing Options ............................................................................................................................................... 143 
• Building a Scan Job ....................................................................................................................................................... 144 

The scanning features in your printer use templates that define the scan settings and the destination for 
an image. 
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Changing the Basic Scan Settings 

To change the basic scan settings: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. To specify 1 or 2-sided scanning: 

a. Touch 2-Sided Scanning, then select an option: 
• 1-Sided: This option scans only one side of the original image and produces 1-sided output 

files. 
• 2-Sided: This option scans both sides of the original image. 
• 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the 

second side. 
b. Touch OK. 

3. To specify the orientation of the original image: 
a. Touch Original Orientation. 
b. On the Original Orientation screen, select an option: 

• Upright Images and Sideways Images refer to the direction the originals are loaded in 
the document feeder. 

• Portrait Originals and Landscape Originals refer to the images on the originals. 
c. Touch OK. 

4. To enter a filename and select a basic file format: 
a. Touch File, then type a name for the scan file. 
b. To select a format, for file format, touch the down arrow, then select an option 
c. Touch OK. 

5. To customize the file format: 
a. On the File screen, for file format, touch the down arrow, then touch Custom. 

Note: You can customize options for PDF, PDF Archival, XPS, or TIFF only. 

b. On the File Format screen, select a file format, then select an option. 
• Multi-page: This option creates a multi-page document from the scanned images. 
• 1 File Per Page: This option creates a separate file for each page scanned. 

c. For Searchable, for PDF, PDF Archival, or XPS, select an option: 
• No: This option creates an unsearchable image of the scanned document. 
• Yes: This option creates a searchable document of the scanned pages. If you select Yes, 

select the language for the search from the menu. 
6. Touch OK. 
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Selecting Advanced Settings 

Advanced settings allow you to control image options, image enhancements, and scan resolution. 

To select advanced settings: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Advanced Settings tab. 
3. To specify the output color: 

a. Touch Output Color, then select an option. 
• Black & White: This option scans in black and white only. 
• Grayscale: Detects and scans various shades of gray. 
• Color: Scans in full color. 

b. Touch OK. 
4. To specify the original type: 

a. Touch Original Type, then select an option. 
• Photo & Text: Optimizes the scan for originals containing both text and graphic images. 
• Photo: Optimizes the scan for originals containing images only. 
• Text: Optimizes the scan for originals containing text only. 
• Map: Optimizes the scan for maps and detailed graphical information. 
• Newspaper/Magazine: Optimizes the scan for printed magazines and newspapers. 

b. Touch OK. 
5. To suppress background variation: 

a. Touch Image Enhancement. 
b. For Background Suppression, touch Auto Suppression. 
c. Touch OK. 

6. To adjust the contrast: 
a. Touch Image Enhancement. 
b. On the Image Enhancement screen, select an option: 

• Auto Contrast: Allows the printer to set the contrast automatically. 
• Manual Contrast: This option allows you to adjust the contrast manually. To increase or 

decrease the contrast, move the Manual Contrast slider up or down. The middle position 
on the slider does not change the contrast. 

c. Touch OK. 
7. To adjust brightness and sharpness: 

a. Touch Image Options. 
b. On the Image Options screen, adjust the sliders as needed: 

• Lighten/Darken: Lightens or darkens the image. 
• Sharpness: Sharpens or softens the image. 

c. Touch OK. 
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8. To adjust saturation: 
a. Touch Saturation. 
b. On the Saturation screen, adjust the sliders to make the image more vivid or more pastel. 
c. Touch OK. 

9. To set the resolution: 
a. Touch Resolution. 
b. On the Resolution screen, select a resolution from 72 dpi through 600 dpi. 
c. Touch OK. 

 

Selecting Layout Adjustments 

Layout adjustments provide additional settings for the size and orientation of the original, and erasing 
the edges. 

To select layout adjustments: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Layout Adjustment tab. 
3. To specify the amount to erase from the edges of your image: 

a. Touch Edge Erase. 
b. On the Edge Erase screen, select an option: 

• All Edges: Erases all four edges by the same amount. Touch the All Edges arrows to 
specify the amount to erase from the edges. 

• Individual Edges: This option specifies different amounts to erase from the edges. To 
specify the amount to erase from each edge, use the arrows. 

c. Touch OK. 
4. To scan the correct area of the original image: 

a. Touch Original Size. 
b. On the Original Size screen, select an option: 

• Auto Detect: This option allows the printer to determine the size of the original. 
• Preset Scan Area: This option specifies the area to scan when it matches a standard paper 

size. In the scrolling list, touch the desired paper size. 
• Custom Scan Area: You can specify the height and width of the area to scan. To specify 

the area, touch the Height-Y and Width-X arrows. 
c. Touch OK. 

5. To manage how the scanner treats blank pages: 
a. Touch Blank Page Management. 
b. Select an option: 

• Include Blank Pages: This option includes scanned pages that are blank. 
• Remove Blank Pages: This option omits scanned pages that are blank. 

c. Touch OK. 
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Selecting Filing Options 

Filing options allow you to update templates, add file destinations, set how the printer handles a file if a 
file name exists, and options for the quality and size of a file. 

To select filing options: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Filing Options tab. 
3. To retrieve new templates and remove outdated ones: 

a. Touch Update Templates > Update Now. 
b. To confirm the update, touch Update Now. 

The updated Pick a workflow screen appears. 
4. From the Pick a Workflow screen, select a workflow. 
5. To define additional network locations as destinations for scanned documents: 

a. Touch Add File Destinations. 
b. On the Add File Destinations screen, touch the desired destinations. 
c. Touch OK. 

Note: Document Management and Add File Destinations can be modified only after scanning to 
network file repositories or scanning to home are set up. For details, see the System Administrator 
Guide at www.xerox.com/office/WC6655docs. 

6. To select the action to take if a file already exists: 
a. Touch If File Already Exists. Select an option. 
b. Touch OK. 

7. To set the quality and file size: 
a. Touch Quality/File Size. 
b. To select a setting, use the slider. The settings range from Highest Compression/Smallest File 

Size to Lowest Compression/Largest File Size. 

Touch OK. 
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Building a Scan Job 

Use this feature to combine an assorted group of originals for assembly into a single scan job. 

To build a scan job: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Job Assembly tab, then touch Build Job > On. 
3. Touch Options. 

a. Select or clear the Display summary window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 
c. Touch OK. 

4. Program and scan the first segment: 
a. Load the originals for the first segment. 
b. Press the green Start button on the control panel. 

Note: If a password is required, contact the system administrator. 

5. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Press the green Start button to scan the originals for that segment. 

6. Repeat the previous step for each remaining segment. 

Note: At any time, you can touch Delete All Segments to modify the job. 

7. Program and scan all segments, then touch Submit Job. The Job Progress screen appears, and the 
individual segments are scanned as a single job. 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Scanning to a USB Flash Drive 

You can scan a document and store the scanned file on a USB Flash drive. The Scan to USB function 
produces scans in .jpg, .pdf, and .tiff file formats. 

To scan to a USB Flash drive: 

Note: Before pressing the Scan button or inserting the USB Flash drive, press the Power Saver button, 
then wait until the Power Saver indicator turns off. 
1. Load the original on the document glass or in the duplex automatic document feeder. 
2. Insert your USB Flash drive into the USB port on the side of the printer. 

Note: If the USB Flash drive is in the USB memory port already, press Services Home, touch 
Workflow Scanning > Change, then select the USB workflow. 

3. On the USB Drive Detected screen, touch Scan to USB. 
4. To change any of the scan settings, on the Workflow Scanning screen, select options. 
5. Press the green Start button. 

The Job Progress screen appears, and the original is scanned. The file is stored on your USB Flash 
drive. 

6. Remove your USB Flash drive from the printer. 
 

 WARNING: Do not remove the USB Flash drive until prompted. If you remove the Flash drive before 
the transfer is complete, the file can become unusable and other files on the drive can be damaged. 
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Scanning to an Email Address 

This section includes: 
• Sending a Scanned Image to an Email Address ................................................................................................ 147 
• Setting Email Options ................................................................................................................................................... 148 
• Changing the Attachment Name and Format ................................................................................................... 148 

When using this feature, the images you scan are sent as email attachments. 
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Sending a Scanned Image to an Email Address 

Before you scan to email, configure the email SMTP and From Field properties. At least one email 
address must exist in the address book. If email properties are not properly configured, the Email icon 
appears grayed out on the touch screen. For details, see the System Administrator Guide for your printer 
model. 

To scan an image and send it to an email address: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Email. 
3. To enter an email address: 

a. Touch Enter Recipient. 
4. Use the touch screen keyboard to type an email address. 

a. Touch Add. 
b. To add additional recipients, touch Add Recipient, then Enter Recipient. 
c. Use the touch screen keyboard to type an email address. 
d. Touch Add. 
e. To organize the recipients, touch one of the recipients on the list, then from the menu, select 

To:, Cc: or Bcc:. 
5. To enter an email address from favorites: 

a. Press the Services Home button, then touch Email. 
b. Touch Favorites. 
c. Touch the desired names, then from the menu, select To:, Cc: or Bcc:. 
d. Touch OK. 

6. To enter an email address from the Device Address Book: 
a. Press the Services Home button, then touch Email. 
b. Touch Device Address Book. 
c. Select the required Email contacts list from the menu. 
d. Touch Search, then use the touch screen keyboard to type part of the name. 
e. Touch Search. 
f. Touch the desired names, then from the menu, select To or Cc or Bcc:. 
g. Touch OK. 

7. To add a subject line: 
a. Touch Subject, then use the touch screen keyboard to type the desired text. 

Note: To modify the default subject, highlight the text in the text field, then touch X to delete it, or 
type over the existing text. 

b. Touch OK. 
8. To change any of the scan to Email settings, use options on the Email, Advanced Settings, Layout 

Adjustment, and Job Assembly tabs. 
9. Press the green Start button. 
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Setting Email Options 

You can use the Email Options tab to configure the email settings. 

To change any of the scan to Email settings, use options on the Email, Advanced Settings, Layout 
Adjustment, and Job Assembly tabs. For details, see Setting Scan Options on page 139. 
 

Changing the Attachment Name and Format 

To change the attachment name and format: 
1. Touch Attachment, then type a name for the file. 
2. Touch the file format menu, then select an option. To specify custom options, touch Custom. For 

details, see Changing Attachment Format Options. 
3. Touch OK. 
 

Changing the Attachment Format Options 

To change the attachment format options: 
1. Touch Attachment. 
2. Touch the file format menu, select Custom. 
3. On the File Format screen, under Format, select an option. 
4. Under File Options, for PDF, PDF Archival, XPS, or TIFF, select an option: 

− Multi-page: This option creates a multi-page document from the scanned images. 
− 1 File Per Page: This option creates a separate file for each page scanned. 

5. Under Password Protect, for PDF only, select an option: 
− No: Disables password protection for the file. 
− Yes: Enables password protection. Touch Enter Password, then to enter a password, use the 

touch screen keyboard. 
6. Touch OK. 
7. For Searchable, for PDF, PDF Archival, or XPS, select an option: 

− No: This option creates an unsearchable image of the scanned document. 
− Yes: This option creates a searchable document of the scanned pages. If you select Yes, select 

the language for the search from the menu. 
8. Touch OK. 
9. Touch OK. 
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Changing the From Address 

To change the From address: 
1. Touch the Email Options tab. 
2. Touch From. 
3. To change the From address using the entered Email address or Favorites:  

− Touch Enter From Address, then use the touch screen keyboard to enter an Email address. 
− Touch Favorites, then select the desired names from the list. 

4. Touch OK. 
5. Change the From address using the device address book: 

a. Touch Device Address Book. 
b. Select the required contacts list from the menu. 
c. Touch Search, then use the touch screen keyboard to type part of the name. 
d. Touch Search. 
e. Select the desired name from the list, then touch Add. 

6. Touch OK. 
 

Changing the Reply To Address 

To change the Reply To address: 
1. Touch the Email Options tab. 
2. Touch Reply To. 
3. To change the Reply To address using the entered Email address or Favorites: 

− Touch Enter Reply To Address, then use the touch screen keyboard to enter an Email address. 
− Touch Favorites, then select the desired names from the list. 

4. Touch OK. 
5. Change the Reply To address using the device address book: 

a. Touch Device Address Book. 
b. Select the required contacts list from the menu. 
c. Touch Search, then use the touch screen keyboard to type part of the name. 
d. Touch Search. 
e. Select the desired name from the list, then touch Add. 

6. Touch OK. 
 

Changing the Message 

To change the message: 
1. Touch the Email Options tab. 
2. Touch Message. 
3. Type the message to include with the images using the touch screen keyboard. 
4. Touch OK. 
 



Scanning 

 

150 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Setting the Quality and File Size 

To set the quality and file size: 
1. Touch the Email Options tab. 
2. Touch Quality/File Size. 
3. To select a setting, use the slider. The settings range from Highest Compression/Smallest File Size to 

Lowest Compression/Largest File Size. 
4. Touch OK. 
 

Setting Encryption 

Encryption helps ensure that email messages cannot be read by anyone other than the intended 
recipient. 

Note: The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC6655docs. 

To set encryption: 
1. Touch the Email Options tab. 
2. Touch Encryption. 
3. For Encryption, touch On or Off. 
4. Touch OK. 
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Scanning to a Destination 

This section includes: 
• Sending a Scanned Image to a Destination ........................................................................................................ 151 

Use Scan to Destination to send scanned images to a remote destination, such as an FTP server or a 
personal computer. 
 

Sending a Scanned Image to a Destination 

Before scanning to a destination, configure the destination folders on the server or share the folder on a 
personal computer. In addition, you must have at least one Scan To Destination in the address book. If 
Scan To Destination properties are not properly configured, the Scan To icon appears grayed out on the 
touch screen. 

To scan an image and send it to a destination: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Scan To. 
3. To select a destination from favorites: 

a. Touch Favorites. 
b. Select the desired contacts from the list. 
c. Touch OK. 

4. To select a destination from the device address book: 
− Touch Device Address Book. 
a. On the Device Address Book screen, select the required contacts list from the menu. 
b. Touch Search, then use the touch screen keyboard to type part of the name. 
c. Touch Search. 
d. Select the desired contact from the list, then touch Add to Recipients. 
e. Touch OK. 
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5. To change any of the scan settings, use options on the Scan To screen. For details, see Setting Scan 
Options on page 139. 

6. To select the action to take if a file already exists: 
a. Touch the Filing Options tab. 
b. Touch If File Already Exists. Select an option. 
c. Touch OK. 

7. To set the quality and file size: 
a. Touch the Filing Options tab. 
b. Touch Quality/File Size. 
c. To select a setting, use the slider. The settings range from Highest Compression/Smallest File 

Size to Lowest Compression/Largest File Size. 
d. Touch OK. 

8. Press the green Start button. 
The Job Progress screen appears, and the original is scanned. The file is stored as a file at the 
destination. 
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This chapter includes: 
• Configuring the Printer for Faxing ........................................................................................................................... 154 
• Basic Faxing ..................................................................................................................................................................... 155 
• Sending an Embedded Fax ........................................................................................................................................ 157 
• Sending a Server Fax .................................................................................................................................................... 170 
• Sending an Internet Fax.............................................................................................................................................. 176 
• Building a Fax Job .......................................................................................................................................................... 184 
• Sending a LAN Fax ........................................................................................................................................................ 185 
• Using the Address Book ............................................................................................................................................... 187 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC6655docs. 
 

 8 Faxing 
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Configuring the Printer for Faxing 

Before you use the fax, you must configure the Fax Settings to make it compatible with your local 
connection and regulations. The Fax Settings include optional features you can use to configure the 
printer for faxing. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific 
printer model, configuration, operating system, or driver type. 

For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs. 
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Basic Faxing 

You can send a fax in one of four ways: 
• Fax/Embedded Fax: This option scans the document, then sends it directly to a fax machine. For 

details, see Sending an Embedded Fax on page 157. 
• Server Fax : This option scans the document, then sends it to a fax server, which transmits the 

document to a fax machine. For details, see Sending a Server Fax on page 170. 
• Internet Fax : This option scans the document, then emails it to a recipient. For details, see Sending 

an Internet Fax on page 176. 
• LAN Fax : This option sends the current print job as a fax. For details, see Sending a LAN Fax on 

page 185. 
 

Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accommodates original 
sizes up to 216 x 356 mm (8.5 x 14 in.). 

 
 

Document Glass Guidelines 

The document glass accommodates original sizes up to 216 x 356 mm (8.5 x 14 in.). 

To copy or scan the following types of originals, use the document glass rather than the duplex 
automatic document feeder. 
• Paper with paper clips or staples attached 
• Paper with wrinkles, curls, folds, tears, or notches 
• Coated or carbonless paper or items other than paper such as cloth or metal 
• Envelopes 
• Books 
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Document Feeder 

 

 

• Insert originals face up, with page one on top. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against the 

originals. 
• The document feeder supports paper weights 

of 50–125 g/m² for 1-sided pages, and 
60–125 g/m² for 2-sided pages. 

• The document feeder supports paper sizes 
from 139.7 x 139.7 mm (5.5 x 5.5 in.) through 
215.9 x 355.6 mm (8.5 x 14 in.). 

• The maximum document feeder capacity is 
approximately 60 sheets of 80 g/m² paper. 

 
 

Duplex Automatic Document Feeder Guidelines 

When loading originals into the duplex automatic document feeder, follow these guidelines: 
• Insert originals face up with the top of the page entering the feeder first. 
• Only place loose sheets of paper in the duplex automatic document feeder. 
• Adjust the paper guides so that they fit against the originals. 
• Only Insert paper in the duplex automatic document feeder when ink on the paper is dry. 
• Do not load originals above the MAX fill line. 
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Sending an Embedded Fax 

When you send a fax from the printer control panel, the document is scanned and transmitted to a fax 
machine using a dedicated telephone line. To use the embedded fax feature, ensure that your printer 
has access to a functioning telephone line with a telephone number assigned to it. 

To send an embedded fax: 
1. Load the original document in the document feeder or on the document glass. 
2. Press the Services Home button, then touch Fax. 
3. To enter recipient details, touch an option or touch Skip. 

− Touch Enter Recipient. 
• To enter the number, use the alphanumeric keypad. To add special dialing characters, at 

the point of insertion during number entry, touch the desired character. 
• Touch Add. 
• To add additional recipients, touch Add Recipient, then Enter Recipient. To enter the 

number, use the alphanumeric keypad, then touch Add. 

Note: One or more dialing pauses can be required between the access number for an outside line 
and the fax number. When inserted, the dial pauses appear as commas in the fax number. 

− Touch Device Address Book. 
• Touch the down arrow, then from the menu select Fax Contacts, Fax Groups, Fax 

Favorites, or All Contacts. 
• Touch the desired contact, then select Add to Recipients. 
• To remove a contact from the list, touch the contact, then touch Remove. 
• Add additional contacts as needed, then touch OK. 

− Touch Favorites. Touch one or more favorites, then touch OK. 
4. Touch 2-Sided Scanning, select an option, then touch OK. 
5. Touch Original Type, select an option, then touch OK. 
6. Touch Resolution, select an option, then touch OK. 
7. Touch Original Size, select an option, then touch OK. 
8. Select more options as needed. For details, see Selecting Fax Options on page 162. 
9. Press the green Start button. The printer scans the pages and transmits the document when all 

pages have been scanned. 

Note: To pause the job, press the Stop button. On the touch screen, touch Resume Scanning to 
continue the job, or Cancel Scanning to cancel the job completely. If you do not make a selection 
within 60 seconds, the job automatically resumes. 

 



Faxing 

 

158 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Basic Fax Settings 

This section includes: 
• Selecting 2-Sided Scanning Options ....................................................................................................................... 158 
• Specifying the Original Type ..................................................................................................................................... 158 
• Setting the Resolution .................................................................................................................................................. 159 
• Specifying the Size of the Original .......................................................................................................................... 159 
• Automatically Suppressing Background Variation ............................................................................................ 159 
• Adjusting the Contrast ................................................................................................................................................. 160 
• Adjusting Brightness and Sharpness ...................................................................................................................... 160 
• Selecting Reducing or Splitting ................................................................................................................................. 160 
• Setting Up Book Faxing ............................................................................................................................................... 161 
 

Selecting 2-Sided Scanning Options 

You can use the 2-Sided Scanning options to set the device to scan one or both sides of an original. 

To set 2-sided scanning: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch 2-Sided Scanning. 
4. Touch an option. 

− 1-Sided: This option scans only one side of the original image and produces 1-sided output 
files. 

− 2-Sided: This option scans both sides of the original image. 
− 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the second 

side. 
5. Touch OK. 
 

Specifying the Original Type 

You can use the Original Type option to specify the type of images to scan. The device uses this 
information to optimize the image quality settings and produce the best quality output. 

To specify the original type: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Original Type. 
4. On the Original Type screen, touch the content type of the original document. 
5. Touch OK. 
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Setting the Resolution 

Resolution determines the quality of graphic images. Image resolution is measured in dots per inch (dpi). 
A 600-dpi setting renders images using 600 dots (pixels) for every inch of the image. A higher resolution 
produces better print quality. 

To adjust the resolution: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Resolution. 
4. On the Resolution screen, touch the desired resolution. 

− Standard: Used for machine-generated text. 
− Fine: Used for line drawings, smaller text, and hand-written text. 
− Superfine: Used for finer text, drawings, and lower-resolution images. 

5. Touch OK. 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Original Size. 
4. On the Original Size screen, select an option. 

− Auto Detect: This option allows the printer to determine the size of the original. 
− Preset Scan Areas: This option specifies the area to scan when it matches a standard paper 

size. In the scrolling list, touch the desired paper size. 
− Custom Scan Area: You can specify the height and width of the area to scan. 

5. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Image Enhancement. 
4. For Background Suppression, touch Auto Suppression. 
5. Touch OK. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Image Enhancement. 
4. On the Image Enhancement screen, select an option. 

− Manual Contrast: This option allows you to adjust the contrast manually. 
− Auto Contrast: This option enables the printer to set the contrast automatically. 

5. Touch OK. 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Image Options. 
4. On the Image Options screen, adjust the sliders as needed. 

− Lighten/Darken: Lightens or darkens the image. 
− Sharpness: Sharpens or softens the image. 

5. Touch OK. 
 

Selecting Reducing or Splitting 

You can determine the method to use for handling images that are too large. 

To select reducing or splitting: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Layout Adjustment tab, then touch Reduce/Split. 
4. Touch an option. 

− Reduce to Fit: This option shrinks large documents to fit on smaller paper. 
− Split Across Pages: This option continues a single image across several pages. 

5. Touch OK. 
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Setting Up Book Faxing 

You can determine the method used for scanning images in a book. 

To select book faxing: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Layout Adjustment tab, then touch Book Faxing. 
4. Touch an option. 

− Off: This is the default setting. 
− Both Pages: Scans both pages of the book. 
− Left Page Only: Scans the left page of the book. 
− Right Page Only: Scans the right page of the book. 

5. To set the amount to erase, touch the Binding Edge Erase arrows as needed. 
6. Touch OK. 
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Selecting Fax Options 

This section includes: 
• Printing a Confirmation Report ................................................................................................................................ 162 
• Selecting the Starting Rate ........................................................................................................................................ 163 
• Adding a Cover Sheet ................................................................................................................................................... 163 
• Sending Header Text .................................................................................................................................................... 164 
• Sending a Delayed Fax ................................................................................................................................................ 164 
• Storing a Fax in a Local Mailbox .............................................................................................................................. 165 
• Storing a Fax in a Remote Mailbox ......................................................................................................................... 165 
• Printing Local Mailbox Documents.......................................................................................................................... 166 
• Printing Remote Mailbox Documents .................................................................................................................... 166 
• Deleting Local Mailbox Documents ........................................................................................................................ 167 
• Storing a Fax for Polling .............................................................................................................................................. 167 
• Printing Faxes Stored for Polling .............................................................................................................................. 168 
• Deleting Faxes Stored for Polling ............................................................................................................................. 169 
• Building a Fax Job .......................................................................................................................................................... 169 
 

Printing a Confirmation Report 

You can print a report that confirms when your faxes are sent or received. The report contains 
information on timeouts, busy signals, and retry failures. 

To set up a confirmation report printing: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Confirmation Report. 
4. Touch an option: 

− Print Confirmation: This option generates a report for all fax jobs. 
− Print on Error Only: This option generates a report only for fax jobs that fail to send. 

5. Touch OK. 
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Selecting the Starting Rate 

Select the highest starting rate unless the destination for the fax you are sending has special 
requirements. 

To select the transmission speed for a fax: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Starting Rate. 
4. Touch an option. 
5. Touch OK. 

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps). 
The slower data rate ensures a more reliable transmission of data. 

 

Adding a Cover Sheet 

You can use the Cover Sheet option to add an introduction page to the beginning of your fax. You can 
add a short comment to the cover sheet, as well as To and From details. 

To include a cover sheet: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Cover Sheet > On. 
4. Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch OK. 
5. Touch the From field, use the touch screen keyboard to type the name of the sender, then touch 

OK. 
6. To add a comment, do one of the following: 

− Touch an existing comment. 
− Touch an <Available> comment, touch the Edit icon, use the touch screen keyboard to type the 

text, then touch OK. 

Notes: 

• To delete an existing comment, touch the comment, then touch X. To confirm the action, touch 
Delete. 

• To edit an existing comment, touch the comment, then touch the Edit icon. To change the 
comment, use the touch screen keyboard, then touch OK. 

7. Touch OK. 
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Sending Header Text 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC6655docs. 

To include the fax header text: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Send Header Text. 
4. Touch an option. 
5. Touch OK. 
 

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The delay can range from 15 
minutes through 24 hours. 

Note: Before you use this this feature, set the printer to the current time. 

To specify the time to send your fax: 
1. Press the Services Home button, then touch Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Delay Send. 
4. Touch Delay Send. 

− Touch the Hour field, then touch the arrows to set a number. 
− Touch the Minute field, then touch the arrows to set a number. 
− If your printer is set to display the 12-hour clock, touch AM or PM. 

5. Touch OK. 
The fax is scanned and saved, then sent at the specified time. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Storing a Fax in a Local Mailbox 

The system administrator must create a mailbox before you can use this feature. For details, see the 
System Administrator Guide at www.xerox.com/office/WC6655docs. 

To store a fax in a local mailbox: 
1. Press the Services Home button, then touch Fax. 
2. Touch Mailboxes. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Mailboxes. 

3. Touch Store To Mailbox. 
4. Touch Local Mailbox. 
5. Touch a mailbox from the list. 
6. If a passcode is required, touch the Mailbox Passcode field, then to enter the four-digit mailbox 

passcode, use the keypad. Touch OK. 
7. Touch OK. 

The mailbox appears as the recipient of the fax. 
8. To select a different mailbox, touch the recipient field, then touch Remove or Edit. 
9. Select additional options as needed. 
10. Touch Start. The originals are scanned and stored in the mailbox. 
 

Storing a Fax in a Remote Mailbox 

To store a fax in a remote mailbox: 
1. Press the Services Home button, then touch Fax. 
2. Touch Mailboxes. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Mailboxes. 

3. Touch Store To Mailbox. 
4. Touch Remote Mailbox. 
5. Touch Enter Remote Fax Number, then to enter the fax number of the remote device, use the 

keypad. Touch OK. 
6. Touch the Mailbox Number field, then to enter the mailbox number, use the alphanumeric keypad. 
7. Touch the Mailbox Passcode field, then, if needed, to enter the four-digit mailbox passcode, use the 

alphanumeric keypad. 
8. Touch OK. 

The mailbox appears as the recipient of the fax. To select a different mailbox, touch the recipient 
field, then touch Remove or Edit. 

9. Select additional options as needed. 
10. Touch Start. The originals are scanned and stored in the remote mailbox. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Printing Local Mailbox Documents 

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a 
Local Mailbox. 

To print local mailbox documents: 
1. Press the Services Home button, then touch Fax. 
2. Touch Mailboxes. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Mailboxes. 

3. Touch Print From Mailbox. 
4. Touch Local Mailbox. 
5. Touch a mailbox from the list. 
6. If a passcode is required, touch the Mailbox Passcode field, then to enter the four-digit mailbox 

passcode, use the keypad. Touch OK. 
7. Touch Print. The documents in the mailbox print. 
8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To 

confirm, touch Empty Mailbox. 
9. Touch Close. 
 

Printing Remote Mailbox Documents 

To print remote mailbox documents: 
1. Press the Services Home button, then touch Fax. 
2. Touch Mailboxes. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Mailboxes. 

3. Touch Print From Mailbox. 
4. Touch Remote Mailbox. 
5. Touch Enter Remote Fax Number, then to enter the fax number of the remote device, use the 

keypad. Touch OK. 
6. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 
7. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit 

mailbox passcode. 
8. Touch Print. The documents in the remote mailbox print. 
9. Touch Close. 
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Deleting Local Mailbox Documents 

To delete local mailbox documents: 
1. Press the Services Home button, then touch Fax. 
2. Touch Mailboxes. 
3. If the Fax tab is selected, touch Add Recipients, then touch Mailboxes. 
4. Touch Store To Mailbox. 
5. Touch Local Mailbox. 
6. Touch a mailbox from the list. 
7. If a passcode is required, touch the Mailbox Passcode field, then to enter the four-digit mailbox 

passcode, use the keypad. Touch OK. 
8. To delete the contents of the mailbox after the device finishes printing, touch Empty Mailbox. To 

confirm, touch Empty Mailbox. 
 

Storing a Fax for Polling 

Fax Polling allows you to store a fax document on the printer and make it available for other fax 
machines to poll. You can also retrieve faxes stored on other fax machines. To use this feature, both the 
polling printer and the remote printer must have the Fax Polling feature. You can store faxes for polling 
as Non-Secure or Secure. When you select Secure Storage, you create a list of remote device fax numbers 
that are allowed to access secure faxes. 

To store a fax: 
1. Touch Polling. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Polling. 

2. Touch Store Polling Files. 
3. To store a Non-Secure fax for polling. 

a. Touch Non-Secure Storage. 
b. Touch OK. 
c. To confirm, touch Update Setting. 

4. To store a Secure fax for polling. 
a. Touch Secure Storage. 
b. Touch Enter a Fax Number, then to enter the fax number for the remote device, use the 

keypad. Touch OK. 
c. Touch OK. 
d. Touch the + button. The fax number is added to the access list. 
e. Continue to enter fax numbers for all of the remote devices that require access. 
f. Touch OK. 
g. To confirm, touch Update Setting. 

5. Select additional options as needed. 
6. Touch Start. The originals are scanned and stored for polling. 
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Printing Faxes Stored for Polling 

Fax Polling allows you to store a fax document on the printer and make it available for other fax 
machines to poll. You can also retrieve faxes stored on other fax machines. To use this feature, both the 
polling printer and the remote printer must have the Fax Polling feature. If you use Remote Fax Polling 
to poll a remote device, you can retrieve faxes immediately. You can can use the Delay Poll option to 
retrieve faxes later at a specified time. The printer can poll more than one remote device at a time. 

To print faxes stored for polling: 
1. Press the Services Home button, then touch Fax. 
2. Touch Polling. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Polling. 

3. Touch Print From Polling Device. 
4. To print faxes that are stored for polling on the local device: 

a. Touch Local Fax Polling. 
b. Touch Print. 
c. To delete stored faxes after they print, touch Empty Fax Polling. To confirm, touch Empty Fax 

Mailbox. 
The local faxes that are stored for polling print. 

5. To print faxes that are stored for polling on a remote device: 
a. Touch Remote Fax Polling. 
b. Touch Enter Fax Number, then to enter the fax number of the remote device, use the keypad. 

Touch OK. 
c. To add a number to the list, touch the + button. Enter additional fax numbers as needed. 
d. To edit the list of fax numbers, touch a number in the list, then touch Remove or Edit. 
e. To set a specific time to poll the remote device, touch Delay Poll. 

• Touch Delay Polling. 
• Touch the Hour field, then touch the arrows to set a number. 
• Touch the Minute field, then touch the arrows to set a number. 
• If your printer is set to display the 12-hour clock, touch AM or PM. 
• Touch OK. 

f. Touch Print. 
The faxes that are stored on the remote device for polling print. 

6. Touch Close. 
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Deleting Faxes Stored for Polling 

To delete faxes that are stored for polling: 
1. Press the Services Home button, then touch Fax. 
2. Touch Polling. 

Note: If the Fax tab is selected, touch Add Recipients, then touch Polling. 

3. Touch Store Polling Files. 
4. Touch an option. 
5. Touch Empty Fax Polling. To confirm, touch Empty Fax Polling again. 
6. Touch OK. 
 

Building a Fax Job 

For details, see Building a Fax Job on page 184. 
 



Faxing 

 

170 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Sending a Server Fax 

If a fax server is connected to the network, you can send a document to a fax machine without requiring 
a dedicated telephone line. 

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax 
server then sends the fax over a telephone line to a fax machine. 

The system administrator must enable the server fax service and configure a fax repository, or filing 
location, before you can use this feature. 

To send a server fax: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 

− Touch Enter Recipient. 
• To enter the number, use the alphanumeric keypad. To add special dialing characters, at 

the point of insertion during number entry, touch the desired character. 
• Touch Add. 
• To add additional recipients, touch Add Recipient, then Enter Recipient. 
• To enter the number, use the alphanumeric keypad, then touch Add. 

Note: One or more dialing pauses can be required between the access number for an outside line 
and the fax number. When inserted, the dial pauses appear as commas in the fax number. 

− Touch Fax Directory. 
• Touch the desired contact, then select Add to Recipients. 
• To remove a contact from the list, touch the contact, then touch Remove. 
• Add additional contacts as needed, then touch OK. 

3. Touch 2-Sided Scanning, select an option, then touch OK. 
4. Touch Original Orientation, select an option, then touch OK. 
5. Touch Resolution, select an option, then touch OK. 
6. Touch Original Size, select an option, then touch OK. 
7. Select more options as needed. For details, see Selecting Server Fax Options on page 173. 
8. Press the green Start button. The printer scans the pages and transmits the document when all 

pages have been scanned. 
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Basic Server Fax Settings 

This section includes: 
• Selecting 2-Sided Scanning Options ....................................................................................................................... 171 
• Specifying the Orientation of the Original ........................................................................................................... 171 
• Setting the Resolution .................................................................................................................................................. 172 
• Specifying the Size of the Original .......................................................................................................................... 172 
 

Selecting 2-Sided Scanning Options 

You can use the 2-Sided Scanning options to set the device to scan one or both sides of an original. 

To set 2-sided scanning: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch 2-Sided Scanning. 
4. Touch an option. 

− 1-Sided: This option scans only one side of the original image and produces 1-sided output 
files. 

− 2-Sided: This option scans both sides of the original image. 
− 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the second 

side. 
5. Touch OK. 
 

Specifying the Orientation of the Original 

You can use the Original Orientation option to specify the layout of the originals that you scan. The 
printer uses the information to determine if images require rotation to produce the desired output 

To specify orientation: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Original Orientation. 
4. On the Original Orientation screen, touch the desired orientation. 

− Portrait Originals and Landscape Originals refer to the images on the originals. 
− Upright Images and Sideways Images refer to the direction the originals are loaded in the 

document feeder. 

Note: If you use the document glass, place the original in the same orientation face down as it was 
face up. 

5. Touch OK. 
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Setting the Resolution 

Resolution determines how fine or grainy graphic images appear. Image resolution is measured in dots 
per inch (dpi). 

To adjust the resolution: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Resolution. 
4. On the Resolution screen, touch the desired resolution. 

− Standard: Used for machine-generated text. 
− Fine: Used for line drawings, smaller text, and hand-written text. 

5. Touch OK. 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Original Size. 
4. On the Original Size screen, select an option. 

− Auto Detect: This option allows the printer to determine the size of the original. 
− Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. 

In the scrolling list, touch the desired paper size. 
− Custom Scan Area: You can specify the height and width of the area to scan. 

5. Touch OK. 
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Selecting Server Fax Options 

This section includes: 
• Adjusting Brightness ..................................................................................................................................................... 173 
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• Adjusting the Contrast ................................................................................................................................................. 174 
• Specifying the Original Type ..................................................................................................................................... 174 
• Sending a Delayed Fax ................................................................................................................................................ 175 
• Building a Fax Job .......................................................................................................................................................... 175 
 

Adjusting Brightness 

You can lighten or darken the image. 

To adjust the image: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Lighten/Darken. 
4. Adjust the Lighten/Darken slider as needed. 
5. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Image Enhancement. 
4. For Background Suppression, touch Auto Suppression. 
5. Touch OK. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Image Enhancement. 
4. On the Image Enhancement screen, select an option: 

− Manual Contrast: This option allows you to adjust the contrast manually. 
− Auto Contrast: This option enables the printer to set the contrast automatically. 

5. Touch OK. 
 

Specifying the Original Type 

The printer optimizes the image quality of the output based on the type of images in the original 
document. 

To specify the original type: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Image Quality tab, then touch Original Type. 
4. Touch the content type of the original document. 
5. Touch OK. 
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Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The delay can range from 15 
minutes through 24 hours. 

Note: Before you use this this feature, set the printer to the current time. 

To specify the time to send your fax: 
1. Press the Services Home button, then touch Server Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Fax Options tab, then touch Delay Send. 
4. Touch Delay Send. 

− Touch the Hour field, then touch the arrows to set a number. 
− Touch the Minute field, then touch the arrows to set a number. 
− If your printer is set to display the 12-hour clock, touch AM or PM. 

5. Touch OK. 
The fax is scanned and saved, then sent at the specified time. 

 

Building a Fax Job 

For details, see Building a Fax Job on page 184. 
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Sending an Internet Fax 

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This 
feature eliminates the need for a dedicated telephone line and the associated service costs. When 
sending an Internet Fax, the document is scanned and sent to an email address. 

To send an Internet fax: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Internet Fax. 
3. To enter recipient details, touch an option or touch Skip. 

− Touch Enter Recipient. 
• To enter an email address, use the touchscreen keyboard, then touch Add. 
• To add additional recipients, touch Add Recipient, then Enter Recipient. To enter an 

email address, use the touchscreen keyboard, then touch Add. 
• To organize recipients, touch one of the recipients in the list, then from the menu, select 

To or Cc. 
− Touch Device Address Book. 

• Touch Search, then to type part of the name, use the touchscreen keyboard. 
• Touch Search. 
• Touch the desired contact, then from menu, select To or Cc. 
• Touch OK. 

4. Touch 2-Sided Scanning, select an option, then touch OK. 
5. Touch Original Type, select an option, then touch OK. 
6. Touch Attachment, select an option, then touch OK. 
7. Touch Subject, then use the touch screen keyboard to type the desired text. Touch OK. 

Note: To modify the default subject, highlight the text in the text field, then touch X to delete it, or 
type over the existing text. 

8. Adjust the Internet fax options as needed. 
9. Press the green Start button. 
10. The printer scans the pages, then after all pages are scanned, it sends the document as an email 

attachment in .pdf or .tif file format. 
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Basic Internet Fax Settings 

This section includes: 
• Selecting 2-Sided Scanning Options ....................................................................................................................... 177 
• Specifying the Orientation of the Original ........................................................................................................... 177 
• Specifying the Attachment Format ........................................................................................................................ 178 
 

Selecting 2-Sided Scanning Options 

You can use the 2-Sided Scanning options to set the device to scan one or both sides of an original. 

To set 2-sided scanning: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch 2-Sided Scanning. 
4. Touch an option. 

− 1-Sided: This option scans only one side of the original image and produces 1-sided output 
files. 

− 2-Sided: This option scans both sides of the original image. 
− 2-Sided, Rotate Side 2: This option scans both sides of the original image, rotating the second 

side. 
5. Touch OK. 
 

Specifying the Orientation of the Original 

You can use the Original Orientation option to specify the layout of the originals that you scan. The 
printer uses the information to determine if images require rotation to produce the desired output 

To specify orientation: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Original Orientation. 
4. On the Original Orientation screen, touch the desired orientation. 

− Portrait Originals and Landscape Originals refer to the images on the originals. 
− Upright Images and Sideways Images refer to the direction the originals are loaded in the 

document feeder. 

Note: If you use the document glass, place the original in the same orientation face down as it was 
face up. 

5. Touch OK. 
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Specifying the Attachment Format 

You can use the Attachment option to specify the file format of the scanned images that you send as an 
attachment. 

To specify the attachment format: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch Attachment. 
4. On the Attachment screen, touch the desired attachment format. 

− PDF: This option produces a Portable Document Format (.pdf). 
− PDF Archival: This option produces a Portable Document Format (.pdf) with embedded fonts. 
− TIFF: This option produces a Tagged Image File Format (.tif) 

5. Touch OK. 
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Specifying the Original Type 

You can use the Original Type option to specify the type of images to scan. The device uses this 
information to optimize the image quality settings and produce the best quality output. 

To specify the original type: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Advanced Settings tab. 
4. Touch Original Type. 

Touch the content type of the original document. 
5. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Advanced Settings tab, then touch Image Enhancement. 
4. For Background Suppression, touch Auto Suppression. 
5. Touch OK. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Advanced Settings tab, then touch Image Enhancement. 
4. On the Image Enhancement screen, select an option: 

− Manual Contrast: This option allows you to adjust the contrast manually. 
− Auto Contrast: This option enables the printer to set the contrast automatically. 

5. Touch OK. 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Advanced Settings tab, then touch Image Options. 
4. On the Image Options screen, adjust the sliders as needed: 

− Lighten/Darken: Lightens or darkens the image. 
− Sharpness: Sharpens or softens the image. 

5. Touch OK. 
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Setting the Resolution 

Resolution determines the quality of graphic images. Image resolution is measured in dots per inch (dpi). 
A 600-dpi setting renders images using 600 dots (pixels) for every inch of the image. A higher resolution 
produces better print quality. 

To adjust the resolution: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Advanced Settings tab, then touch Resolution. 
4. On the Resolution screen, touch the desired resolution. 

− 72 dpi: This option produces acceptable image quality for onscreen viewing, and the smallest 
file size. 

− 100 dpi: This option produces good image quality for onscreen viewing, and small file size. 
− 150 dpi: This option produces good image quality for onscreen viewing, and small file size. 
− 200 x 100 dpi: This option produces good image quality, and moderate file size. 
− 200 dpi: This option produces good image quality, and moderate file size. This setting is the 

default. 
− 300 dpi: This option produces high image quality, and large file size. 
− 400 dpi: This option produces higher image quality, and larger file size. 
− 600 dpi: This option the highest image quality, and the largest file size. 

5. Touch OK. 

Note: Check with the system administrator to determine the largest file size that the email system 
allows. 

 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Layout Adjustment tab, then touch Original Size. 
4. On the Original Size screen, select an option. 

− Auto Detect: This option allows the printer to determine the size of the original. 
− Preset Scan Area: This option specifies the area to scan when it matches a standard paper size. 

In the scrolling list, touch the desired paper size. 
− Custom Scan Area: You can specify the height and width of the area to scan. 

5. Touch OK. 
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Setting the Quality and File Size 

The Quality/File Size option lets you choose from three settings that balance the quality of the image 
and the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and 
transmitting over the network. 

To set the Internet fax quality and file size: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Internet Fax Options tab, then touch Quality/File Size. 
4. On the Quality/File Size screen, use the slider to select a setting. The settings range from Highest 

Compression/Smallest File Size to Lowest Compression/Largest File Size. 
5. Touch OK. 
 

Adding a Message 

You can use the Message option to add a brief message to the file you want to send. 

To add a message: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Internet Fax Options tab, then touch Message. 
4. Type a message using the touch screen keyboard. 
5. Touch OK. 
 

Specifying a Reply To Address 

You can use the Reply To option to include an email address that you want the recipient to reply to. This 
option is useful if you want the recipient to reply to your email address rather than to the device email 
address. 

To set the Reply To address: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Internet Fax Options tab, then touch Reply To. 
4. Enter the details using one or more of the available options. 

− Enter Reply To Address: This option allows you to enter an email address manually. Use the 
touch screen keyboard to type an email address, then touch OK. 

− Device Address Book: This option allows you to select an entry from your address book. Touch 
the desired name then touch OK. 
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Printing an Acknowledgment Report 

If the status of each recipient is known, you can print a delivery status report. The printer waits for a 
delivery receipt from each recipient, then prints the report. 

Note: The report could be delayed depending on the response time of the recipients. 

To print an acknowledgment report: 
1. Press the Services Home button, then touch Internet Fax. 
2. To enter recipient details, touch an option or touch Skip. 
3. Touch the Internet Fax Options tab, then touch Acknowledgment Report. 
4. Touch Print Report. 
5. Touch OK. 
 

Building a Fax Job 

For details, see Building a Fax Job on page 184. 
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Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 

To build a fax job: 
1. Press the Services Home button, then touch the appropriate fax. 
2. Enter the details using one or more of the available options. 

− Enter Recipient: This option allows you to enter recipient details manually. 

Note: One or more dialing pauses can be required between the access number for an outside line 
and the fax number. When inserted, the dial pauses appear as commas in the fax number. 

− Favorites: You can use this option to access and select contacts that are designated as 
favorites in your address book. 

− Device Address Book: This option allows you to select contacts from your address book and 
add them to your recipients list. 

3. Touch the Job Assembly tab, then touch Build Job > On. 
4. Touch Options. 

a. Select or clear the Display Summary window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 
c. Touch OK. 

5. Program and scan the first segment: 
a. Load the originals for the first segment. 
b. Select the required settings, such as layout adjustments, image quality, and options. 
c. Press the green Start button on the control panel. 

6. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Using the appropriate tabs, select the required settings. 
d. Press the green Start button to scan the originals for that segment. 

7. Repeat the previous step for each remaining segment. 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 

8. When all of the segments are programmed and scanned, touch Submit Job. 
The Job Progress screen appears, and the individual segments are sent as a single job. 

9. On the Job Progress screen, to view a summary of the job, touch Details. 

Note: If necessary, touch Delete > Delete Job to cancel the job. 
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Sending a LAN Fax 

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax 
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with 
notes, and set options. You can select confirmation sheets, send speed, fax resolution, send time, and fax 
dialing options. 

Notes: 

• If you select the Fax job type, some features, such as Edge Enhancement, Thin Line 
Enhancement, and Black Enhancement are turned off. 

• Not all printer models support this feature. 

To send a LAN fax: 
1. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File > Print or press CTRL+P. 
2. Select your printer, then click Properties to open the print driver dialog box. 
3. On the Printing Options tab, from the Job Type list, select Fax. 
4. To add recipients, click Recipients, then select an option. 

Do one or more of the following: 
− Click the Add From Phonebook button. In the Add From Phonebook window, click the arrow, 

then select a phonebook from the list. Select names from the upper list or to search for a 
recipient, type a name, then click the search icon. To add a name to the Fax Recipients list, 
select the name, then click the down arrow to move it to the bottom list. When you are finished, 
click OK. To add additional names, repeat this procedure. 

− Click the Add Recipient button, type the recipient name and fax number, add other 
information, then click OK. Add new recipients as needed. 

5. To include a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a 
Cover Sheet. On the Cover Sheet information tab, type notes that you want to appear on the cover 
sheet. 

6. To include a watermark on the cover sheet, click the Image tab, then for Watermark, select Custom. 
− To include a text watermark, from the menu, select Text. A Text Watermark uses the characters 

typed in the Text field as the watermark. You can create a text watermark to print on a 
document. Select options such as font size, font type, font color, and angle. Click OK. 

− To include a picture watermark, from the menu, select Picture. A Picture Watermark uses an 
image as the watermark. The picture file can be in .bmp, .gif, or .jpg format. You can create a 
picture watermark to print on a document, and select options including size and position on the 
page. Click the folder icon, navigate to the file location, then select the desired picture file. To 
include the file, click Open. Click OK. 
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7. In the Cover Sheet Notes window, type notes to appear on the cover sheet. 
8. On the Options tab, select the options for this fax. 

− For Confirmation, select an option:  
• Disabled: No confirmation notification occurs. 
• Send to Printer: This option instructs the printer to print a confirmation sheet. A fax 

confirmation notifies you that the fax was sent successfully. The confirmation shows the 
names and fax numbers of the recipients. 

• Send to Email: Instructs the printer to send the confirmation sheet to the email address 
that you specify. Enter a valid email address. 

− Send Speed: This option selects the appropriate fax transmission rate in kilobits per second 
(kbps) or bits per second (bps). If you live in an area where the phone lines do not support 
high-speed fax/data transmission, select a lower transmission rate. A lower transmission rate 
reduces the chance of transmission errors. 

− Fax Resolution: Fax Resolution affects the amount of detail that is reproduced during the fax 
transmission. Higher resolution fax transmissions consume more memory and take longer to 
send. Select an option. 
• Standard: Used for machine-generated text. 
• Fine: Used for line drawings, smaller text, and hand-written text. 
• Superfine: Used for finer text, drawings, and lower-resolution images. 

− Send Time: Select the time to send the fax. You can delay the send for up to 24 hours. 
− Dialing Prefix: To dial an outside line, select Dialing Prefix. Type the dialing prefix in the field. 
− Credit Card: To use a credit card, debit card, or calling card to charge for faxes, select Credit 

Card. Type the card number in the field. 
9. Click OK. 
10. In the Printer Properties window, click OK. 
11. In the Print window, click OK or Print. 
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Using the Address Book 

This section includes: 
• Adding an Individual Entry to the Device Address Book ................................................................................ 187 
• Editing an Individual Address Book Entry ............................................................................................................. 187 
• Editing or Deleting Favorites in the Device Address Book .............................................................................. 188 
 

Adding an Individual Entry to the Device Address Book 

The Device Address Book can contain up to 5000 contacts. If the Create New Contact button is 
unavailable, the address book has reached its capacity. 

Before you can use this feature, the system administrator must enable users to view and manage the 
Device Address Book. 

To add a recipient to the Device Address Book: 
1. Press the Services Home button, then touch Email, Fax, or Internet Fax. 
2. Touch Device Address Book. 
3. Touch Create New Contact. 
4. Touch each of the fields required, then to enter information, use the touch screen keyboard. Touch 

OK. 
5. To add name and company information for the new entry, to the right of the contact field, touch 

the i button. 
a. Enter a name into the First Name, Last Name, or Company field, then touch OK. 

Note: The first entry into one of the fields becomes the display name for the contact information. 

b. Enter names into the remaining fields, then touch OK after each entry. 
c. At the Additional Contact Information page, touch OK. 

6. To mark any entered contact information as a favorite, touch the star icon. 
7. To save the contact to the Device Address Book, touch OK. 
 

Editing an Individual Address Book Entry 
1. Press the Services Home button, then touch Email, Fax, or Internet Fax. 
2. Touch Device Address Book. 
3. Touch the contact name. 
4. Touch Details. 
5. Touch the field that requires, then to edit the entry, use the the touch screen keyboard. Touch OK. 
6. To change the display name for the contact, touch the i button, edit the information in the fields, 

then touch OK. 
7. To mark any entered contact information as a favorite, touch the star icon. 
8. To save the contact to the Device Address Book, touch OK. 
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Editing or Deleting Favorites in the Device Address Book 
1. Press the Services Home button, then touch Email, Fax, or Internet Fax. 
2. Touch Device Address Book. 
3. Touch the desired entry, using the scroll arrows as needed. 
4. Touch Details. 
5. To mark any entered contact information as a favorite, touch the star icon. 
6. To delete a favorite, to the right of the appropriate field touch the star icon. 
7. Touch OK. 
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Cleaning the Printer 

This section includes: 
• General Precautions ...................................................................................................................................................... 190 
• Cleaning the Exterior .................................................................................................................................................... 191 
• Cleaning the Scanner ................................................................................................................................................... 191 
• Cleaning the Interior .................................................................................................................................................... 193 
 

General Precautions 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. 
Do not touch or scratch the surface of the drum. 

  

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum 
cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion. 

 
 

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized 
spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Exterior 

Clean the exterior of the printer once a month. 
• Wipe the paper tray, output tray, control panel, and other parts with a damp, soft cloth. 
• After cleaning, wipe with a dry, soft cloth. 
• For stubborn stains, apply a small amount of mild detergent to the cloth and gently wipe the stain 

off. 
 

 CAUTION: Do not spray detergent directly on the printer. Liquid detergent could enter the printer 
through a gap and cause problems. Never use cleaning agents other than water or mild detergent. 

 
 

Cleaning the Scanner 

Xerox recommends that you clean the scanner about once a month or when vertical lines appear on 
copies or scans from the automatic document feeder. Vertical lines appear when anything is spilled on 
the scanner or when debris or dust collect on any of the surfaces. Clean scanner glass surfaces and feed 
rollers ensure the best possible copies and scans. 
 

Cleaning the Document Glass and Cover 
1. Slightly dampen a soft, lint-free cloth with water. 
2. Remove any paper from the duplex automatic document feeder. 

 
3. Open the document cover. 
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4. Wipe the surfaces of the document glass and CVT glass until they are clean and dry. 

Note: For best results, to remove marks and streaks, use a standard glass cleaner. 

 
5. Wipe the white underside of the document cover until it is clean and dry. 

 
6. Close the document cover. 
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Cleaning the Feed Rollers and Separation Pad on the Automatic Document Feeder 
1. Open the duplex automatic document feeder top cover. 

 
2. With a clean, lint-free cloth moistened with water, wipe the feed rollers and the separation pad until 

they are clean. 

 
Note: If the duplex automatic document feeder feed rollers and separation pad get stained with 
toner or debris, they can cause stains on the documents. To remove stains, use a soft lint-free cloth 
dampened with a neutral detergent or water. 

3. Close the document feeder top cover. 
 

Cleaning the Interior 

To prevent stains inside the printer that can deteriorate print quality, clean the interior of the printer 
regularly. Clean the printer interior whenever you replace the drum cartridge. 

After clearing paper jams or replacing a toner cartridge, inspect the inside of the printer before closing 
the printer covers and doors. 
• Remove any remaining pieces of paper or debris. For details, see Clearing Paper Jams on page 220. 
• Remove any dust or stains with a dry, clean cloth. 
  

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. 
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Cleaning the Laser Lenses 

If prints have voids or light streaks through one or more colors, use the following instructions to clean the 
laser lenses. 
 

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 

 

1. Open the side door. 

 
2. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise. 
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3. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings 
facing up. 

 
Notes: 

• Be careful not to spill toner when handling the waste cartridge. 
• After removing the waste cartridge, do not touch the area shown in the illustration. 
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4. Place the removed waste cartridge on a level surface. 

 
 

 CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side. 
 

 
5. Remove the cleaning rod from inside the printer. 
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6. Insert the cleaning rod into one of the four cleaning holes until it clicks, then pull it out. Repeat this 
two more times. 

 
7. Repeat the procedure for the holes in the other three slots. 
8. Return the cleaning rod to its original location. 
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9. Reinsert the waste cartridge. 

 
Note: If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully. 

10. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise. 

 
11. Close the side door. 
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Cleaning the Color Toner Density Sensors 
1. Turn off the printer. 
 

 CAUTION: If the optional Productivity Kit (HD) is not installed, ensure that the Ready LED is off 
before you turn off the printer. The data in the memory is cleared when the printer is turned off. 

 

2. Push down on the rear door release and pull open the door. 

 
3. Open the side door. 
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4. To unlock the waste cartridge, turn the waste cartridge lever 90-degrees counterclockwise. 

 
5. Grasp the handle of the waste cartridge, then pull it out. To prevent toner spills, keep the openings 

facing up. 

 
Notes: 

• Be careful not to spill toner when handling the waste cartridge. 
• After removing the waste cartridge, do not touch the area shown in the illustration. 
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6. Place the removed waste cartridge on a level surface. 

 
 

 CAUTION: To avoid toner spills or malfunction, do not lay the waste cartridge on its side. 
 

 
7. Turn the control panel so that it is not positioned above the top cover. 
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8. Open the top cover. 

 
9. Put your fingers through the loops on both sides of the transfer belt unit, then pull it out. 

 
10. Use a dry cotton swab to clean the color toner density sensors. 
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11. Reinsert the belt unit into the printer. 

 
12. Close the top cover. 

 
13. Reinsert the waste cartridge. 

 
Note: If the waste cartridge does not fit into place properly, ensure that the belt is inserted fully. 
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14. To lock the waste cartridge, turn the waste cartridge lock lever 90-degrees clockwise. 

 
15. Close the side door. 

 
16. Close the rear door. 
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Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. The impression counts 
shown are used for billing. 

To view Billing and Usage information: 
1. At the printer control panel, press the Machine Status button. 
2. To view basic impression counts, touch the Billing Information tab: 

− Black Impressions: Total number of pages printed with no color specified. 
− Color Impressions: Total number of pages printed that specify color. 
− Total Impressions: Total number of color impressions plus black impressions. 

3. To view detailed usage information, touch Usage Counters, then select an option. 
4. To return to the Services Home menu, press the Services Home button. 
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Ordering Supplies 

This section includes: 
• When to Order Supplies ............................................................................................................................................... 206 
• Viewing Printer Supply Status ................................................................................................................................... 207 
• Consumables ................................................................................................................................................................... 207 
• Routine Maintenance Items ...................................................................................................................................... 208 
• Recycling Supplies .......................................................................................................................................................... 208 
• Toner Cartridges ............................................................................................................................................................. 209 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC6655supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=order&Language=English
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Viewing Printer Supply Status 

You can check the status and percentage of life remaining for your printer supplies at any time using 
Xerox® CentreWare® Internet Services or the control panel. 

To view printer supply status using Xerox® CentreWare® Internet Services: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: For details, see the System Administrator Guide at www.xerox.com/office/WC6655docs. 

2. Select the Status tab. 
3. Under Status, click Supplies. 

To view printer supply status using the control panel: 
1. At the control panel, press Machine Status, then touch the Supplies tab. 
2. To view details about a specific cartridge, including the part number for reordering, touch C, M, Y, 

or K. 
3. To return to the Supplies tab, touch Close. 
4. To view more details, touch Other Supplies, then select an option. 
5. To return to the Other Supplies screen, touch Close. 
6. To return to the main screen, press Services Home. 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Notes: 

• Each consumable includes installation instructions. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 
• Imaging Unit 
• Transfer Unit Kit 
• Waste Cartridge 
• Fuser 
• Feed Roller Kit 
 

Recycling Supplies 

For more information on the Xerox® supplies recycling program, go to: www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=recyclesupplies&Language=English
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Toner Cartridges 

This section includes: 
• General Precautions ...................................................................................................................................................... 209 
• Replacing a Toner Cartridge ...................................................................................................................................... 209 
 

General Precautions 
 

 WARNINGS: 

• When replacing a toner cartridge, be careful not to spill the toner. If any toner spills, avoid 
contact with clothes, skin, eyes, and mouth. Do not inhale the toner dust. 

• Keep toner cartridges out of the reach of children. If a child accidentally swallows toner, have the 
child spit out the toner, and rinse out their mouth with water. Consult a physician immediately. 

• Use a damp cloth to wipe off spilled toner. Never use a vacuum cleaner to remove spills. Electric 
sparks inside the vacuum cleaner can cause a fire or explosion. If you spill a large volume of 
toner, contact your local Xerox representative. 

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge can catch 
fire and cause burn injuries or an explosion. 

 

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

 

• Do not open covers and doors during printing. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the drum cartridge. 
• Do not place anything on top of the printer. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
 

Replacing a Toner Cartridge 

When a toner cartridge reaches its usable life span, the control panel displays a message. Job Tracker 
displays the toner status in the Printer Status window. When a toner cartridge is empty, the printer stops 
and displays messages on the control panel and in the Job Tracker Printer Status window. 

Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner remaining 
amount displayed could be inaccurate. 
 

Note: Each toner cartridge includes installation instructions. 
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Moving the Printer 
 

 WARNINGS: 

• To lift the printer, always use at least two people to grasp the hand holds on each side of the 
printer. 

• To prevent dropping or tipping the printer, hold the printer between two people, with each 
person using one hand underneath to hold the printer and the other hand on top to stabilize it. 

• If the optional 550-Sheet Feeder is installed, uninstall it before you move the printer. If the 
optional 550-Sheet Feeder is not fixed to the printer securely, it could fall to the ground and 
cause injury. 

 

To move the printer: 
1. Always turn off the printer and wait for the printer to shut down. For details, see Turning the Printer 

On and Off on page 41. 
2. Disconnect the power cord and other cables from the back of the printer. 
 

 WARNING: To prevent electric shock, never touch the power plug with wet hands. When removing 
the power cord, ensure that you pull the plug and not the cord. Pulling the cord can damage it, which 
can lead to fire or electric shock. 

 

3. Remove any paper or other media from the output tray. If the output tray extension is extended, 
close it. 
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4. Remove the paper from the paper tray. 
Keep the paper wrapped and away from humidity and dirt. 

 
5. When lifting the printer, grasp the areas as shown. 

 
Notes: 

• When moving the printer, do not tilt it more than 10 degrees to the front, back, left, or right. 
Tilting the printer more than 10 degrees can cause toner spillage. 

• When moving the printer over a long distance, remove the imaging units and toner cartridges 
to prevent toner from spilling. Repack the printer and its options using the original packing 
material and boxes or a Xerox Repackaging Kit. For a repacking kit and instructions, go to 
www.xerox.com/office/WC6655support. 

 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered 
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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After moving the printer: 
1. Reinstall any parts you removed. 
2. Reconnect the printer to the cables and power cord. 
3. Plug in and turn on the printer. 
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General Troubleshooting 

This section includes: 
• Printer Fails to Power On ............................................................................................................................................. 214 
• Printer Resets or Turns Off Frequently ................................................................................................................... 215 
• Printer Fails to Print ....................................................................................................................................................... 215 
• Printing Takes Too Long .............................................................................................................................................. 216 
• Document Prints From Wrong Tray ........................................................................................................................ 217 
• Automatic 2-Sided Printing Problems .................................................................................................................... 217 
• Printer Makes Unusual Noises ................................................................................................................................... 217 
• Paper Tray Fails to Close ............................................................................................................................................. 217 
• Condensation Has Formed Inside the Printer ..................................................................................................... 218 
• Date and Time Are Incorrect ..................................................................................................................................... 218 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 

Printer Fails to Power On 
 

Probable Causes Solutions 

One of the power switches is not turned on. Turn on both power switches. For details, see Turning the Printer On 
and Off on page 41. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. For details, see Turning the Printer On and Off on 
page 41. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 260. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
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Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not plugged into the outlet 
correctly. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. 

A system error occurred. Turn off the printer, then turn it on again. Print the Error History 
from the Information Pages of the Printer Setting Utility. If the error 
persists, contact your Xerox representative. 

The printer is connected to an uninterruptible 
power supply. 

Turn off the printer, then connect the power cord to a suitable 
outlet. 

The printer is connected to a power strip 
shared with other high-power devices. 

Plug the printer directly into the outlet or into a power strip that is 
not shared with other high-power devices. 

 
 

Printer Fails to Print 
 

Probable Causes Solutions 

The printer has an error. • To clear the error, follow the onscreen prompts. 
• Turn off the printer, then turn it on again. If the error persists, 

contact your Xerox representative. 

The printer is out of paper. Load paper into the tray. 

A toner cartridge is empty. Replace the empty toner cartridge. 

The front door is open. • Ensure that the toner cartridge and imaging unit are installed 
and fully seated. 

• Ensure that the door is closed completely. 
• Turn off the printer, then turn it on again. If the error persists, 

contact your Xerox representative. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is plugged in 
correctly to the printer and the outlet, then turn on the printer. For 
details, see Turning the Printer On and Off on page 41. If the error 
persists, contact your Xerox representative. 
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Probable Causes Solutions 

The printer is busy. • A previous print job could be the problem. On your computer, 
you can use the printer properties to delete all print jobs in the 
print queue. 

• Load the paper in the tray. 
• At the control panel, touch Job Status. If the print job does not 

appear check the Ethernet connection between the printer and 
the computer. 

• At the control panel, touch Job Status. If the print job does not 
appear, check the USB connection between the printer and the 
computer. Turn off the printer, then turn it on again. 

The printer cable is disconnected. • At the control panel, touch Job Status. If the print job does not 
appear check the Ethernet connection between the printer and 
the computer. 

• At the control panel, touch Job Status. If the print job does not 
appear, check the USB connection between the printer and the 
computer. Turn off the printer, then turn it on again. 

 
 

Printing Takes Too Long 
  

Probable Causes Solutions 

The printer is set to a slower printing mode. 
For example, the printer could be set to print 
on Heavyweight paper. 

It takes more time to print on certain types of special paper. Ensure 
that the paper type is set properly in the driver and at the printer 
control panel. For details, see Print Speed on page 261. 

The printer is in Power Saver mode. It takes time for printing to start when the printer is coming out of 
Power Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Office Demo Page. If the 
page prints at the rated speed of the printer, you could have a 
network or printer installation issue. For additional help, contact the 
system administrator. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 
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Document Prints From Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print 

driver or set the paper source to Automatically Select. 
 

Note: To have the print driver select the tray, set the tray used as 
the paper source to Auto Selection Enabled. 

 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for 
2-sided printing. Envelopes and labels cannot be used for 2-sided 
printing. For details, see Supported Standard Types and Weights for 
Automatic 2-Sided Printing on page 57 and Supported Standard 
Paper Sizes for Automatic 2-Sided Printing on page 56. 

Incorrect setting. In the print driver Properties, select 2-Sided Print on the 
Paper/Output tab. 

 
 

Printer Makes Unusual Noises 
 

Probable Causes Solutions 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox representative. 

 
 

Paper Tray Fails to Close 
 

Probable Causes Solutions 

The paper tray does not close fully. • The paper tray lift plate is not locked down. Push down on the 
paper stack at the back of the tray until it locks down. 

• If the tray is extended for legal size paper, the tray protrudes 
when it is inserted into the printer. 

• Some debris or an object is blocking the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 
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Condensation Has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. • Allow the printer to acclimate for several hours before operation. 
• Allow the printer to operate for several hours at room 

temperature. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
 
 

Date and Time Are Incorrect 
 

Probable Causes Solutions 

The Date and Time Setup is set to Manual 
(NTP Disabled). 

To change the Date and Time to Automatic, enable NTP in Xerox® 
CentreWare® Internet Services. For details, see the System 
Administrator Guide at www.xerox.com/office/WC6655docs. 

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details, see Setting 
the Date and Time at the Control Panel on page 46. 

 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=Man&Language=English
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Jams 

This section includes: 
• Locating Paper Jams ..................................................................................................................................................... 219 
• Clearing Paper Jams...................................................................................................................................................... 220 
• Minimizing Paper Jams ................................................................................................................................................ 231 
• Troubleshooting Paper Jams ..................................................................................................................................... 232 
 

Locating Paper Jams 
 

 WARNING: Never touch a labeled area on or near the heat roller in the fuser. You can get burned. If 
a sheet of paper is wrapped around the heat roller, do not try to remove it immediately. Switch off 
the printer immediately and wait 40 minutes for the fuser to cool. Try to remove the jam after the 
printer has cooled. If the error persists, contact your Xerox representative. 

 

 CAUTION: Do not attempt to clear any paper jams using tools or instruments. This can permanently 
damage the printer. 

The following illustration shows where paper jams can occur along the paper path: 

 
 

1. Optional Tray 
2. Duplex Automatic Document Feeder 
3. Fuser 

4. Bypass Tray 
5. Tray 1 

 

 



Troubleshooting 

 

220 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Clearing Paper Jams 

This section includes: 
• Clearing Paper Jams from the Duplex Automatic Document Feeder ........................................................ 220 
• Clearing Paper Jams from the Bypass Tray ......................................................................................................... 222 
• Clearing Paper Jams from the Tray 2 Area .......................................................................................................... 225 
• Clearing Paper Jams from the Fuser Area ............................................................................................................ 228 
 

Clearing Paper Jams from the Duplex Automatic Document Feeder 
1. Remove the remaining paper from the duplex automatic document feeder. 
2. Open the duplex automatic document feeder top cover. 

 
3. If the paper is jammed in the exit of the duplex automatic document feeder, pull it out as 

illustrated. 
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4. To reset the interlock switch and clear the paper jam message, open and close the back door. 

 
5. Reload the document in the duplex automatic document feeder, then adjust the guides against the 

edges of the paper. 
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Clearing Paper Jams from the Bypass Tray 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Remove any paper from the bypass tray. 

 
2. Grasp both sides of the bypass tray, then pull it straight out of the printer. 

 
3. Pull out the tray until it stops. 
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4. To remove the tray, lift the front of it slightly, then pull it out of the printer. 

 
5. Remove the jammed paper. 

 
6. To reset the interlock switch and clear the paper jam message, open and close the back door. 
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7. Insert tray 1 into the printer, then push it in all the way. 

 
Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 
printer. 

8. Insert the bypass tray back into the printer. Push the tray in all the way. 

 
9. If the control panel prompts you, on the screen, verify the paper size and type. 

a. Touch Size, then, for a standard paper size, touch an option. 
b. Touch Type, then, for the paper type, touch an option. 

10. Touch OK. 
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Clearing Paper Jams from the Tray 2 Area 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Pull out tray 2 until it stops. 

 
2. To remove the tray, lift the front of it slightly, then pull it out of the printer. 
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3. Remove any paper jammed at the front of the printer. 

 
4. To reset the interlock switch and clear the paper jam message, open and close the back door. 
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5. Insert tray 2 into the printer, then push it all the way in. 

 
Note: If the tray is extended for legal size paper, the tray protrudes when it is inserted into the 
printer. 

6. If the control panel prompts you, on the screen, verify the paper size and type. 
a. Touch Size, then, for a standard paper size, touch an option. 
b. Touch Type, then, for the paper type, touch an option. 
c. Touch OK. 
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Clearing Paper Jams from the Fuser Area 
1. Push down on the rear door release and pull open the door. 

 
2. If paper is jammed in the fuser, raise both green levers to open the fuser. 

 
3. To open the paper guide, raise the green handle. 
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4. Remove any jammed paper from the back of the printer. 

 
5. Close the paper guide on the fuser. 

 
6. Lower the levers to their original position. 
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7. Remove any jammed paper from the back of the printer. 

 
8. Close the rear door. 
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Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 54. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Do not open sealed packages of paper until you are ready to load them into the printer. 
• Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture 

loss or gain. 

Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/rmlna. 
 

http://www.xerox.com/printer-supplies/recommended-paper/enus.html
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 232 
• Paper Misfeeds ................................................................................................................................................................ 232 
• Label and Envelope Misfeeds .................................................................................................................................... 233 
• Paper Jam Message Stays On ................................................................................................................................... 233 
• Jams During Automatic 2-Sided Printing .............................................................................................................. 233 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, then replace it with new dry paper. 

Too much static electricity is present. Try a new ream of paper. 

Unsupported paper is in the tray. Use only Xerox approved paper. For details, see Supported Paper on 
page 54. 

Humidity is too high for coated paper. • Feed paper one sheet at a time. 
• Fan paper before loading it in the paper tray. 

  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, see Supported Paper on 
page 54. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

• Load label sheets according to the instructions from the 
manufacturer. 

• Load labels in the tray, face up. 
For details, see Labels. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. Load envelopes in the bypass tray only. 
For details, see Loading Envelopes in the Bypass Tray on page 67. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can cause 
wrinkling. 

• Use supported envelopes. For details, see Guidelines for Printing 
Envelopes on page 66. 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and ensure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer and close any door that is open. 

The rear door interlock switch is not reset. To reset the interlock switch and clear the paper jam message, open 
and close the back door. 

Note: Check for, and remove, torn pieces of paper in the paper path. 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Use paper of the correct size, thickness, or type. For details, see 
Supported Paper Sizes for Automatic 2-Sided Printing on page 56. 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 54. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 234 
• Solving Print-Quality Problems .................................................................................................................................. 235 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC6655support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

  

Notes: 

• To enhance print quality, the toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

  
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer and set the paper type correctly. Follow the guidelines in this 
section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. The guaranteed range for optimal 
print quality is 15–28°C (59–82°F) and 20–70% relative humidity. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, see Supported Paper on page 54. 
• Use only dry, undamaged paper. 
 

 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 

  

• Ensure the paper type selected in your print driver matches the paper type on which you are 
printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 55. 

 

Solving Print-Quality Problems 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. For details, see Information Pages on page 25. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 

Notes: 

• To enhance print quality, toner cartridges for many models of equipment have been designed 
to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 
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Symptom Cause Solution 

Faded printouts with multiple 
colors faded 

 

 

The paper type is heavier or 
thicker than the paper type 
selection. 

Adjust the paper type settings. 

The paper being used is outside 
the recommended specification 
range. 

Replace the paper with a 
recommended size and type, and 
confirm that your control panel and 
print driver settings are correct. For 
details, see Supported Paper on page 
54. 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. It can 
take several prints before full quality is 
restored. 

 

The bias transfer roller voltage is 
insufficient for the paper type. 

Verify that the paper loaded in the tray 
matches the paper type selected at the 
control panel and in the print driver. 

The settings in the application or 
print driver are incorrect. 

Print the Graphics Demo Page. If If the 
Demo Page looks correct, the printer is 
printing properly. Your application or 
incorrect settings in the print driver are 
probably causing the print-quality 
problems. 

The paper is damp. Replace the paper. 

 

Note: Store your paper and other 
media properly for optimum print 
quality. For details, see Paper Storage 
Guidelines on page 55. 

Only one color is faded 

 
 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. It can 
take several prints before full quality is 
restored. 

The imaging unit is defective. If the defect occurs in one color only, 
replace the corresponding imaging 
unit. 
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Symptom Cause Solution 

Copy colors are the wrong color 

 

The color balance is not adjusted 
properly. 

Adjust the color balance. 

1. At the printer control panel, 
press the Machine Status 
button. 

2. Touch Tools > Service 
Settings. 

3. Touch Feature Defaults > 
Image Quality > Color 
Balance. 

4. Select a color, then adjust the 
highlights, midtones, and 
shadows. 

5. Touch Save. 
6. Touch Save Defaults. 
7. To return to the Services Home 

menu, press the Services 
Home button. 

Stray black dots, white areas, or 
dropouts 

 

 

The paper is outside the 
recommended specification 
range. 

Replace the paper with a 
recommended size and type, and 
confirm that your control panel and 
print driver settings are correct. For 
details, see Supported Paper on page 
54. 

 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 207. 

There is debris on the transfer 
roller. 

Wipe the transfer roller with a clean, 
lint-free cloth moistened with water. 

Note: Do not touch the transfer roller 
or the exposed end of the transfer belt. 
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Symptom Cause Solution 

• Vertical black or color streaks 
or multiple colored streaks or 
lines 

• Streaks in one color only 

 
 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 207. 

 

The imaging unit is defective. If the defect occurs in one color only, 
replace the corresponding imaging 
unit. 

Debris in the printer is dragging 
against the toner before the 
toner is fused. 

Remove any paper or debris from the 
paper path. 

Streaks in multiple colors There is debris in the transfer belt 
unit. 

Inspect and clean or replace the 
transfer belt unit. 

Offset image 

 

Image is printed a second time. • Verify that the paper you are using 
is the correct type for the printer 
and is loaded properly. For details, 
see Supported Paper on page 54. 

• Verify that the paper loaded in the 
tray matches the paper type 
selected at the control panel and in 
the print driver. 

To verify paper type at the control 
panel, press Machine Status, then 
touch Machine Information > Paper 
Tray Status. 
Note: If the problem continues, select 
the next lighter paper type. 
• For uncoated paper, the papers 

from lightest to heaviest are Plain, 
Lightweight Cardstock, and 
Cardstock. 

• For coated paper, the papers from 
lighter to heavier are Lightweight 
Glossy Cardstock and Glossy 
Cardstock. 
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Symptom Cause Solution 

Colors align incorrectly 

 

Color has shifted outside the 
designated area. 

To initiate the color registration cycle, 
open and close the rear door. 

White lines or streaks running 
through one color only 

 

Something is blocking the lens for 
the affected color. 

Clean the lens for the affected color. 

 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 207. 

 

The toner was stored in a high 
temperature area. 

Replace the toner cartridge. 

White line or lines running 
through all colors 

 

Paper or debris is dragging 
against the bottom of the 
transfer belt unit. 

• Remove any paper or debris from 
the paper path. 

• Replace the transfer belt unit. 
• For assistance, go to the Xerox® 

Support website at 
www.xerox.com/office/WC6655sup
port. 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Symptom Cause Solution 

Slanted printing 

 

The paper guides are not set 
correctly. 

Reset the paper tray guides. For details, 
see Loading Paper on page 58. 

Incomplete fusing 

 

Toner appears to be missing from 
the print or is easy to rub off. 

• Verify that the paper you are using 
is the correct type for the printer 
and is loaded properly. 

• Verify that the paper loaded in the 
tray matches the paper type 
selected at the control panel and in 
the print driver. 

• Set the paper type to one type 
heavier. 

To verify paper type at the control 
panel, press Machine Status, then 
touch Machine Information > Paper 
Tray Status. For more information 
about paper weights, see the Offset 
image section of this table. 
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Symptom Cause Solution 

Partial blanks, creased paper, or 
blotted printing 

 

The paper is damp. Replace the paper. 

The paper is outside the 
recommended specification 
range. 

Replace the paper with a 
recommended size and type, and 
confirm that your control panel and 
print driver settings are correct. For 
details, see Supported Paper on page 
54. 

Condensation inside the printer 
causes partial blanks or creased 
paper. 

Turn on the printer and leave it on for 
at least one hour remove the 
condensation. For assistance, go to the 
Xerox® Support website at 
www.xerox.com/office/WC6655suppor
t. 

The toner cartridges are not 
Xerox® toner cartridges. 

Replace the toner cartridges with 
genuine Xerox® toner cartridges. For 
details, see Consumables on page 207. 

The paper is impeded in the 
paper path. 

• Remove any paper or debris from 
the paper path. 

• Ensure that the paper trays are 
closed. 

• Ensure that the rear cover is closed 
and locked. 

 

 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 
 

Symptoms Solutions 

Lines or streaks present in copies only made 
from the document feeder. 

There is debris on the document glass. When scanning, the paper 
from the document feeder passes over the debris creating lines or 
streaks. Clean all glass surfaces with a lint-free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the debris 
creates a spot on the image. Clean all glass surfaces with a lint-free 
cloth. 

The reverse side of the original is showing on 
the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark. • Copy: To lighten, darken, or adjust contrast, use the Image 
Quality settings. 

• Scan: To lighten, darken, or adjust contrast, use the Advanced 
Settings Tab. 

 

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Fax Problems 

This section includes: 
• Problems Sending Faxes .............................................................................................................................................. 244 
• Problems Receiving Faxes ........................................................................................................................................... 245 
• Selecting the Starting Rate ........................................................................................................................................ 245 
• Printing Fax Reports ...................................................................................................................................................... 246 
 

Note: If you cannot send and receive faxes, make sure that you are connected to an approved 
analog telephone line. The fax cannot send or receive when connected to a digital phone line. 

If you cannot send or receive faxes correctly, refer to the following tables. 
 



Troubleshooting 

 

244 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

Problems Sending Faxes 
 

Symptoms Causes Solutions 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass to send the 
fax. 

The document is scanned at an 
angle. 

The document feeder guides are not 
adjusted to the width of the document. 

Adjust the document feeder guides to 
fit the width of the document. 

The fax received by the recipient 
is blurry. 

The document is incorrectly positioned. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. Adjust the 
contrast. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is 
working, then send the fax again. 

There is a problem with the fax 
machine of the caller. 

Make a copy to verify that your printer 
is operating correctly. If the copy was 
printed correctly, have the recipient 
verify the condition of their fax 
machine. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly. • Document feeder: Place the original 
document face up. 

• Document glass: Place the original 
document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 

The fax is not installed or is not 
enabled. 

Verify that the fax is installed and 
enabled. 

Server Fax is enabled. Make sure that Server Fax is disabled. 

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Problems Receiving Faxes 
 

Symptoms Causes Solutions 

The received fax is blank. There is a problem with the telephone 
connection or with the fax machine of 
the caller. 

Verify that the printer can make clean 
copies. If it can, have the caller send 
the fax again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, the 
printer could not have enough memory. 
The printer does not answer when 
memory is low. Delete stored 
documents and jobs then wait for the 
existing job to complete. This increases 
available memory. 

The received fax size is reduced. The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents. Documents could be 
reduced based on the available paper 
supply in the printer. 

Faxes cannot be received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic reception. 

The memory is full. Load paper if it is empty, and then 
print the faxes stored in the memory. 

The telephone line is incorrectly 
connected. 

Verify the telephone line connection. If 
it is disconnected, connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that your printer 
is operating correctly. If the copy prints 
correctly, have the recipient verify their 
fax machine is operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/WC6655support. 
 

Selecting the Starting Rate 

Select the highest starting rate unless the destination for the fax you are sending has special 
requirements. 

To select the transmission speed for a fax: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Starting Rate. 
3. Touch an option. 
4. Touch OK. 

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps). 
The slower data rate ensures a more reliable transmission of data. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=WorkCentre+WC6655&PgName=tech&Language=English
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Printing Fax Reports 

You can print the following fax reports from the printer control panel: 
• Activity Report 
• Protocol Report 
• Fax Address Book Report 
• Options Report 
• Pending Jobs Report 

To print a fax report: 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Service Settings > Fax Service. 
3. Touch Print Fax Reports. 
4. Touch the desired report, then touch Print. 
5. Touch Close. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 28. 
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Getting Help 

This section includes: 
• Control Panel Messages .............................................................................................................................................. 247 
• Using the Integrated Troubleshooting Tools ...................................................................................................... 248 
• Online Support Assistant ............................................................................................................................................. 251 
• More Information .......................................................................................................................................................... 251 

Your printer comes with utilities and resources to help you troubleshoot printing problems. 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When a fault or warning 
condition occurs, the control panel displays a message informing you of the problem. For many status 
and warning messages, the control panel Information provides additional information. 
 

Control Panel Help 

When a fault occurs that stops the printing operation, such as a paper jam, a message appears on the 
screen. A graphical illustration appears to indicate the location of the fault with a brief explanation of 
the action to take to clear the fault. The illustration changes to indicate multiple locations and actions to 
take. 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, a message appears on the control panel to inform you of the problem. 
Warning messages inform you about printer conditions, such as low supplies or open doors, that require 
your attention. If more than one warning condition occurs, only one appears on the control panel. 
 

Viewing Current Faults on the Control Panel 

When a fault condition occurs, a message appears on the control panel to inform you of the problem. 
Fault messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one fault occurs, only one is displayed on the control panel. 
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Viewing Job Status on the Control Panel 

To view current or saved jobs on the control panel: 
1. At the control panel, press the Job Status button. 
2. To view a list of active jobs, touch Active Jobs. 
3. To view a list of completed jobs, touch Completed Jobs. 
4. To view a list of secure prints, touch Secure Print Jobs. 
5. To view a list of secure faxes received, touch Secure Fax Receive. 
 

Using the Integrated Troubleshooting Tools 

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can 
help with troubleshooting certain problems. The Demo Page prints an image using many colors to show 
the current ability of the printer to print. The Error History report prints information on the most recent 
printer errors. 
 

Starting a Customer Self-Help Session 

If your printer displays an error message that you cannot clear, you can connect the printer remotely to 
a Xerox troubleshooting server. The troubleshooting server analyzes diagnostic information from your 
printer and provides you with helpful solutions. 

To start a remote troubleshooting session: 
1. In your open application, select File > Print > Printer Properties. 
2. Click More Status. 
3. In the Customer Self-Help window, click Troubleshooting. 
4. Follow the directions provided. 
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Printing Information Pages 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages, then touch the desired information 

page. 
3. Touch Print. 
 

Note: Information pages can also be printed from Xerox® CentreWare® Internet Services. 
  
 

Setting Rights to Access the Configuration Report and Information Pages 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings > Configuration / Information Pages. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 28. 

3. To restrict users from printing the Configuration Report and Information Pages, touch System 
Administrator Only. To allow all users access, touch All Users. 

4. To print the Configuration Report at power on, touch Yes. To disable the setting, touch No. 
5. Touch OK. 
 

Printing the Configuration Report 

The Configuration Report prints each time the printer is turned on. 

To print the configuration report: 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages > Configuration Report > Print. 
3. After the report prints, touch Close. 

To disable printing the configuration report at power on: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Tools tab, then touch Device Settings > Configuration/Information Pages. 
3. For Print Configuration at Power On, touch No. 
4. Touch OK. 
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Viewing Billing and Usage Information 
1. At the printer control panel, press the Machine Status button. 
2. To view basic impression counts, touch the Billing Information tab: 

− Black impressions are the number of pages printed with no color specified. 
− Color impressions are the number of pages printed that specify color. 
− Total impressions are the total number of color impressions plus black impressions. 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

3. To view detailed usage information, touch Usage Counters. 
 

Locating the Serial Number on the Control Panel 
1. At the printer control panel, press the Machine Status button. 
2. To see the model, serial number, and software version, touch the Machine Information tab. 
 

Viewing Printer Supply Status 
1. At the control panel, press Machine Status, then touch the Supplies tab. 
2. To view details about a toner cartridge, including the part number for reordering, touch Black, Cyan, 

Magenta, or Yellow. 
3. To return to the Supplies tab, touch Close. 
4. For details about other supply items, touch Other Supplies. Then touch an item to display 

additional details. 
5. To return to the Other Supplies screen, touch Close. 
6. To return to the Supplies tab, touch Close. 
7. To print the Supplies Usage page, touch Print Supplies Report. 
8. To return to the main screen, touch Services Home. 
 

Xerox® CentreWare® Internet Services 

Xerox® CentreWare® Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

Xerox® CentreWare® Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in Xerox® CentreWare® Internet Services or the System Administrator Guide. 
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Online Support Assistant 

The Online Support Assistant is a knowledge base that provides instructions and troubleshooting help to 
solve your printer problems. You can find solutions for print-quality problems, paper jams, software 
installation issues, and more. 

To access the Online Support Assistant, go to www.xerox.com/office/WC6655support. 
 

More Information 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer • www.xerox.com/office/WC6655docs 
• www.xerox.com/office/WC6655i_docs 

Recommended Media List United States: www.xerox.com/rmlna 
European Union: www.xerox.com/rmleu 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

• www.xerox.com/office/WC6655support 
• www.xerox.com/office/WC6655i_support 

Information about menus or error messages Press the control panel Help (?) button. 

Information pages To print from the control panel, press Machine Status > 
Machine Information > Information Pages. 
To print from Xerox® CentreWare® Internet Services, click 
Status > Information Pages. 

Xerox® CentreWare® Internet Services 
documentation 

In Xerox® CentreWare® Internet Services, click Help. 

Order supplies for your printer • www.xerox.com/office/WC6655supplies 
• www.xerox.com/office/WC6655i_supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful 
tips, and customized features to meet your 
individual needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 

Third party and open source software To locate third party and open source software disclosure 
notices and terms and conditions, go to the product page at: 
• www.xerox.com/office/WC6655support 
• www.xerox.com/office/WC6655i_support 
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Printer Configurations and Options 

Available Configuration 

Network printer with copy, automatic 2-sided printing, scan, and fax functions, and USB or network 
connectivity. 
 

Standard Features 

The printer provides the following features: 
 

Print speed Standard mode: Up to 36 ppm for Letter and 35 ppm for A4 

2-Sided print speed Standard mode: Up to 24 ppm for Letter and 23 ppm for A4. 

Functions Copy, scan, print, and fax 

Note: Not all options listed are supported on all printers. Some options 
apply only to a specific printer model, configuration, operating system, 
or driver type. 

Standard memory • 4 GB Device Memory 
• Internal 160 GB hard drive 

Print resolution • Standard print-quality mode: 600 x 600 dpi 
• High-Resolution print-quality mode: 2400 x 600 dpi 

2-Sided printing Up to 163 g/m² from any tray 

Maximum print size Legal (216 x 356 mm, 8.5 x 14 in.) 

Paper capacity • Bypass Tray: 150 sheets 
• Tray 1: 550 sheets 
• Optional 550-Sheet Feeder 

Copy speed • 1-sided copy: 36 cpm 
• 2-sided copy: 24 cpm 

Copy resolution 600 x 600 dpi 

Maximum copy size Legal (216 x 356 mm, 8.5 x 14 in.) 

Document feeder Duplex Automatic Document Feeder 

Document feeder capacity 60 sheets 

Scan resolution • Optical: 600 x 600 dpi 
• TWAIN: Up to 9600 dpi interpolated 
• WIA: Up to 600 dpi 

Maximum scan size • Document Glass: 215.9 x 355.6 mm (8.5 x 14 in.) 
• Duplex Automatic Document Feeder: 215.9 x 355.6 mm (8.5 x 14 in.) 
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Supported scanning • Scan to SMB 
• Scan to FTP 
• Scan to Email 
• Scan to USB Memory 
• Scan to Computer (USB) 
• WSD Scan 

File formats • JPEG 
• TIFF 
• PDF 

Control panel 7.0-inch LCD touch screen and keypad navigation 

Connectivity • Universal Serial Bus (USB 2.0) 
• USB Flash Drive 
• Ethernet 10/100/1000Base-TSupport for AirPrint 
• Wi-Fi Direct 

Remote access Xerox® CentreWare® Internet Services 
 
 

Options and Upgrades 
• Wireless network adapter 
• 550-Sheet Feeder 

Note: You can install a maximum of one optional tray on this printer. 

• Printer Stand 
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Physical Specifications 

Weights and Dimensions 
 

 Standard Configuration Standard Configuration with Optional 
550-Sheet Feeder 

Width 53.8 cm (21.2 in.) 53.8 cm (21.2 in.) 

Depth 55.3 cm (21.8 in.) 55.3 cm (21.8 in.) 

Height 62.5 cm (24.6 in.) 76.3 cm (30.0 in.) 

Weight 37.6 kg (82.9 lb.) 43.9 kg (96.8 lb.) 
 
 

Standard Configuration Physical Specifications 
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Physical Specifications with Optional 550-Sheet Feeder 

 
 

Clearance Requirements 
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Clearance Requirements with Optional 550-Sheet Feeder 
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Environmental Specifications 

Temperature 
• Operating temperature: 5–32°C (41–90°F) 
• Optimum temperature: 15–28°C (59–82°F) 
 

Relative Humidity 
• Minimum–Maximum Humidity Range: 10–85% 
• Optimal Humidity Range: 20–70% relative humidity at 28°C (82°F) 

Note: Under extreme environmental conditions, such as 10°C and 85% relative humidity, defects 
can occur due to condensation. 

 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

100–127 VAC +/-10%, (90–140 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

 
 

Power Consumption 
• Power Saver Mode (Sleep): 2.7 W 
• Ready, with fuser on: 71 W 
• Continuous printing: 565 W 

This printer does not consume electric power when the main power switch is turned off even if the 
printer is connected to an AC outlet. 
 

ENERGY STAR Qualified Product 
 
 
 
 

 

This product is ENERGY STAR® qualified under the ENERGY STAR Program 
Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

ENERGY STAR settings are preset on Xerox® equipment at the factory to switch to Power Saver modes 
after 2 minutes from the last copy or print. 
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Performance Specifications 

Power on: Approximately 4 minutes. 
 

Print Speed 

Maximum print speeds for 1-sided continuous printing on Plain media are 36 ppm for Letter (8.5 x 11 in.) 
and 35 ppm for A4 (210 x 297 mm). Print speed slows with larger and heavier media. 

Note: Print speeds are the same for Standard print-quality mode and High-Resolution print-quality 
mode. 

Several factors affect print speed: 
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels. 
• 2-sided printing: The maximum print speeds for 2-sided continuous printing are 24 ppm for Letter 

(8.5 x 11 in.) and 23 ppm for A4 (210 x 297 mm). 
• Paper size. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger 

sizes reduce print speeds. 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance 
with these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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European Union 
 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 
• March 9, 1999: Radio & Telecommunications Terminal Equipment Directive 1999/5/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
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Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ 
 

Power Consumption and Activation Time 

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. After the last print, the device 
switches to Ready mode. In this mode, the device can print again immediately. If the product is not used 
for a period of time, the device switches to a Power Saver mode. In these modes, to enable reduced 
product power consumption, only essential functions remain active. 

The product takes slightly longer to produce the first print after it exits Power Saver mode than it takes in 
Ready mode. This delay is the result of the system waking up from Power Saver mode and is typical of 
most imaging products on the market. 

You can set a longer activation time or completely deactivate the Power Saver mode. This device can 
take longer to switch to a lower energy level. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 
 

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ
http://www.xerox.com/about-xerox/environment/enus.html
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Environmental Choice Certified to Office Machines CCD-035 
 
 
 

 

This product is certified to Environmental Choice standard for office machines, meeting 
all requirements for reduced environmental impact. As part of achieving certification, 
Xerox Corporation has proven this product meets the Environmental Choice criteria for 
energy efficiency. Certified copier, printer, multifunctional device, and fax products 
must also meet criteria such as reduced chemical emissions and demonstrate 
compatibility with recycled supplies. Environmental Choice was established in 1988 to 
help consumers find products and services with reduced environmental impacts. 
Environmental Choice is a voluntary, multi-attribute, and lifecycle-based environmental 
certification. This certification indicates that a product has undergone rigorous 
scientific testing, exhaustive auditing, or both, to prove its compliance with stringent, 
third-party, environmental performance standards. 

 
 

Germany 

Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device 
the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies 
Blue Angel criteria for environmental acceptability in terms of device design, 
manufacture, and operation. For more information, go to: www.blauer-engel.de. 

 
 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

http://www.blauer-engel.de/
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Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 
99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or 

may be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 



Regulatory Information 

 

270 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 
 User Guide 
 

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
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Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of 

a court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer 
for a province) 

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 

• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of 
a province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be 
connected to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing 
in response to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). 
To be certain of the number of devices that can be connected to a line, as determined by the RENs, 
contact the local Telephone Company. For products approved after July 23, 2001, the REN is part of the 
product identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN 
without a decimal point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately 
shown on the label. 
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To order the correct service from the local Telephone Company, you could also have to quote the codes 
in the following list: 
• Facility Interface Code (FIC) = 02LS2 
• Service Order Code (SOC) = 9.0Y 
 

 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. You, 
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this 
machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the 
Telephone Company interrupts your service, they can advise you of your right to file a complaint with 
the FCC if you believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If 
unauthorized repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state 
tariffs. Contact the state public utility commission, public service commission, or corporation commission 
for information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
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Canada 

This product meets the applicable Industry Canada technical specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
 

 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The REN assigned to each terminal device provides an indication of the maximum number of terminals 
allowed to be connected to a telephone interface. The termination on an interface could consist of any 
combination of devices. The only limitation to the number of devices is the requirement that the sum of 
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the 
equipment. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

The Facsimile has been approved in accordance with the Council Decision 1999/5/EC for pan-European 
single terminal connection to the public switched telephone network (PSTN). However, due to differences 
between the individual PSTNs provided in different countries, the approval does not give an 
unconditional assurance of successful operation on every PSTN network terminal point. 

In the event of a problem you should contact your authorized local dealer. 

This product has been tested to and is compliant with ES 203 021-1, -2, -3, a specification for terminal 
equipment for use on analog-switched telephone networks in the European Economic Area. This product 
provides a user-adjustable setting of the country code. The country code should be set prior to 
connecting this product to the network. Refer to the customer documentation for the procedure for 
setting the country code. 
 

Note: Although this product can use either loop disconnect (pulse) or DTMF (tone) signaling, we 
recommend that you set it to use DTMF signaling for more reliable and faster call setup. 
Modification of this product, connection to external control software, or connection to an external 
control apparatus not authorized by Xerox® will invalidate its certification. 

 
 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 
The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected 
to the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 
For repeat calls to the same number: 
− There shall be no more than 10 call attempts to the same number within any 30 minute period 

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of 
another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should 
not exceed five. 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds 
• European Union: www.xerox.com/environment_europe 

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=msdsna&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmenteu&Language=English
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=customersupport&Language=English
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate


Recycling and Disposal 

 

 Xerox® WorkCentre® 6655/6655i Color Multifunction Printer 279 
 User Guide 
 

North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information 
about Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=WorkCentre+WC6655&PgName=environmentna&Language=English
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents 
mean that used electrical and electronic products and batteries should 
not be mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items. 

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a manufacturer-approved service facility. 
 



Recycling and Disposal 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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